
Teamstudio®

Software Engineering Tools for IBM Lotus Notes® and 

Domino®

USER GUIDE

Edition 30



Copyright Notice

This User Guide documents the entire Teamstudio  product suite, including:

Teamstudio Analyzer

Teamstudio CIAO!®

Teamstudio CIAO!® Server

Teamstudio Configurator

Teamstudio Delta

Teamstudio Design Manager

Teamstudio Profiler

Teamstudio Undo

Teamstudio Validator

Please read the section(s) of the guide that relates to the Teamstudio tool(s) you use.

This document, as well as the software described in it, is furnished under license, 
the terms of which are contained in the license agreement. This document may be 
used or copied only in accordance with the terms of such license. The information 
contained in this document is subject to change without notice. We make no 
commitment to update the information contained in this document. Teamstudio 
assumes no responsibility or liability for technical or editorial errors or omissions 
that may appear in this document, or for the use of this document.

© Copyright 2013 Teamstudio, Inc. All Rights Reserved.

Teamstudio and CIAO! are registered trademarks of Teamstudio, Inc.  IBM, Lotus 
Notes, Notes and Domino are registered trademarks of IBM Corporation.  Windows is a 
registered trademark of Microsoft Corporation.  All other trademarks are trademarks or 

registered trademarks of their respective owners.



Contents

Chapter 1 Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

About This Book  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

Chapter 2 Teamstudio Analyzer  . . . . . . . . . . . . . . . . . . . 5

Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Using Analyzer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Starting Analyzer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Analyzing the Database Design . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Defining the Analysis Output Database. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Creating a new analysis output database . . . . . . . . . . . . . . . . . . . . . . . . . .  8
Selecting an existing analysis output database  . . . . . . . . . . . . . . . . . . . .  10

Controlling Incremental Updates. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Auditing a Design  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Selecting an audit output database. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15
Using the Design Notes Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Starting the Analysis  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

The Analysis Output Database . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Adding Comments to Design Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Deleted Items . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
Getting Started: Viewing Analysis Information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
Summary of Views. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

The Analysis Output Database Views . . . . . . . . . . . . . . . . . . . . . . . . . . .  25
Customizing the Template . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
Finding all References to a Field . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

The Audit Function. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
Auditor Components  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
Using the Audit Output Database  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

Analyzer’s Filters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Reviewing Filters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
Disabling or Activating Filters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
Editing or Creating Classes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
Editing or Creating Severity Definitions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .38
Editing or Creating Filters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Filter Examples  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
  ii



Auditor Filters for Advanced Users  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .50
TMSRTContains . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
TMSGetParentValue . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
TMSGetChildValues( <Form Alias>::<field name> ). . . . . . . . . . . . . . . . . . . . . . . . 53
TMSIncludeChildren( UNID; LOGIC )  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
TMSSearchAll( Flag; Value )  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
TMSIncludeParent( UNID )  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
TMSAliasDuplicate/TMSTitleDuplicate( FieldName )  . . . . . . . . . . . . . . . . . . . . . . 56

Chapter 3 Teamstudio CIAO! . . . . . . . . . . . . . . . . . . . . . 57

Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .57

Using CIAO! . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .58
Working with Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

CIAO!-Awareness in Domino Designer 8.5.1  . . . . . . . . . . . . . . . . . . . .  62
Checking an Element Out . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  64
How Using CIAO! Check-out Can Keep Your Changes Safe  . . . . . . . .  70
Undoing a Check-out. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  71
What if I need an element someone else has checked out? . . . . . . . . . . .  71
Checking an Element In  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  73
Deleting and Recovering Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  76
Working with Element History . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  78

Making Versions and Restoring to Previous Versions. . . . . . . . . . . . . . . . . . . . . . . . 83
Understanding Version Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  85
Restoring the Entire Database Design. . . . . . . . . . . . . . . . . . . . . . . . . . .  87

Working with CIAO! Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97
Checkout Activity Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  97
Change Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  100

About CIAO! Version Control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
Promoting a Database . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
Changing CIAO! Preferences and Views  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

Changing CIAO! Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  105
Making changes in the view  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  107

Administering CIAO! . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .109
Alternate Ways to Set up CIAO! . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
Enabling or Disabling CIAO! Control of a Database . . . . . . . . . . . . . . . . . . . . . . . 111
To put a database under CIAO! control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112
About CIAO! Client and Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115
Configuring CIAO! to Watch Documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115
Working with Issue Tracking. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117

Requiring an Issue to Check In/Out an Element . . . . . . . . . . . . . . . . . .  120
Configuring an Issue Tracking Database in CIAO!  . . . . . . . . . . . . . . .  120

Understanding CIAO! Config Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121
Configuring the Basics  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  122
Configuring What CIAO! Watches . . . . . . . . . . . . . . . . . . . . . . . . . . . .  122
iii  



Authority  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  123
Issues . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  124
Versioning . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  124

Working with Templates and Template-linked Elements  . . . . . . . . . . . . . . . . . . . . 125
Requiring Comments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126
Assigning CIAO! Feature Access . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126

Building Promotion Paths. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128
Building Promotion Paths  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128
Working with Promotion Paths  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133

Log Database Reference. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135
Understanding CIAO! Client and CIAO! Log Entries  . . . . . . . . . . . . . . . . . . . . . . 136
Understanding CIAO Log Views. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137
Understanding CIAO! Log Fields . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 138
Understanding CIAO! Log Forms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139
Moving a Database’s History. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139
About the Log Database ACL . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139

Chapter 4 Teamstudio Configurator . . . . . . . . . . . . . . 141

Using Configurator . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 141
Getting Started . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .143
Specifying Where to Search. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .144

Specifying Your Selection by Formula or View . . . . . . . . . . . . . . . . . .  146
Specifying Where to Store Configurator Results. . . . . . . . . . . . . . . . . . . . . . . . . . . 146
Selecting Design Elements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 148
Selecting Match Options for Searches. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149

Matching Whole Words. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  149
Matching Accented Characters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  150
Matching Case . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  151
Using Wildcards. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  152
Using Regular Expressions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  152

Telling Configurator What Action to Take  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 158
Find  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  158
Find All  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  158
Replace All. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  159

When Configurator Finds a Match  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 159

Viewing the Configurator Output Log . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 165

Building Configurable Database Designs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 167

Chapter 5 Teamstudio Delta  . . . . . . . . . . . . . . . . . . . . 169

Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 169
How Delta Works. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170
Using Delta  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171
  iv



Comparing Elements or Documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .174
About Difference Symbols  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177
Delta Options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 178
Viewing Design Element Descriptions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 178
Viewing Differences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 181

Color-coded Text. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  184
Locating Differences within the Show Differences Window . . . . . . . .  184
Hiding Identical Properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  184
Showing Tabbed Tables  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  185

Showing Data Document Differences from the Notes Client . . . . . . . . . . . . . . . . . 186
Matching Elements or Documents  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 188

Why Use Matching?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  188
When You Can’t Match Elements or Documents . . . . . . . . . . . . . . . . . . . . . . . . . . 190
Understanding Comparison Results  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 193

Setting Delta Preferences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  193
Filtering Data Document Comparison Results . . . . . . . . . . . . . . . . . . .  195
How the Smart Filter Works . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  196

Hiding an Item with the Smart Filter. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 196
Configuring the Smart Filter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197

Sharing Design Changes through Merging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .199
Common Uses for Manual Merging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 200

Creating Difference Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .201
Report Options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  204

About Difference Report Symbols  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 205
About Difference Report Fonts and Colors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 205
Filtering Low-level Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 207
Simplifying Data Document Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 209
Viewing Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 210

Viewing Delta Reports  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  210

Chapter 6 Teamstudio Design Manager . . . . . . . . . . . 213

Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .213
Starting Design Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 215

About the Design Manager Window. . . . . . . . . . . . . . . . . . . . . . . . . . .  216

Building a Library You Can Share  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .217
Opening a Database . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 217
Opening a Library . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 219
Opening Used Libraries. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 220
Closing Libraries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 221
Opening Inherited Databases. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 221
Grouping Objects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 222
Creating Group Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 222

Organizing a Library . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .226
v  



Organizing Actions in a Library  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 226
Making Actions Shared or Unshared. . . . . . . . . . . . . . . . . . . . . . . . . . .  226
Moving Actions on the Action Bar . . . . . . . . . . . . . . . . . . . . . . . . . . . .  227

Deleting Elements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 227
Comparing Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228
Adding Comments and Changing Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228
Previewing Visual Elements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 230
Viewing Elements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 231

Viewing Aliases . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  232
Selecting Child Elements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  232

Working with Databases and Libraries. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 233
Using Library Filters to Display Fewer Elements . . . . . . . . . . . . . . . . . . . . . . . . . . 233
Saving the Database List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 234
Closing Databases . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 235
Copying Design Elements Using Drag-and-Drop . . . . . . . . . . . . . . . . . . . . . . . . . . 235

Copying Actions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  235
Copying Duplicate Elements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  236
About Template Inheritance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  237

Identifying Dependencies  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 239
Unlinking Template Inheritance  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 241
Prohibiting / Allowing Design Refresh or Replace . . . . . . . . . . . . . . . . . . . . . . . . . 242
Scanning for Missing Dependencies . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 243
Synchronizing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 245
Setting the Copy History Log  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 245

Chapter 7 Teamstudio Profiler  . . . . . . . . . . . . . . . . . . 249

Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 249
Client and Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  249

Using Teamstudio Profiler Client . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 250
Running Profiler With Your Application . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .250
Reviewing Profiler Results  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 253

Using the Call Tree  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  256

Using Teamstudio Profiler Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 258
Profiler Configuration Database  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 258
Profiler Log Database  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 265

Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 267

Chapter 8 Teamstudio Undo . . . . . . . . . . . . . . . . . . . . 269

Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 269

About the Undo Log Database(s) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 270

Configuring Undo to Track Changes to Your Databases . . . . . . . . . . . . . . . . . . . . 270
  vi



Using Undo . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .272
Viewing Design Element Changes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 272
Undoing a Change . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 273

Chapter 9 Teamstudio Validator  . . . . . . . . . . . . . . . . . 275

Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .275

Working with Validator . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .276
Starting Validator . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 276
Running Validator . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 277
Understanding Validator Report Views . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 279

By Created . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  280
By Document. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  280
By Error . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  280

Viewing an Error . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 281
Common Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  282

Understanding Common Error Types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 283
Could Not Validate Document with Form  . . . . . . . . . . . . . . . . . . . . . .  284
Database was not Found . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  285
Document/Note was not Found . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  288
Fields Inconsistency  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  290
Keyword Field Contains Incorrect Values  . . . . . . . . . . . . . . . . . . . . . .  292
Missing Dependency . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  294
Orphaned Agent Data Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  294
Save / Replication Conflicts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  296
URL is Invalid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  298

Chapter 10  Contacting Teamstudio . . . . . . . . . . . . . . . 301

Contacting Teamstudio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .301
  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 301
By Phone . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 301

North and Latin America. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  301
Europe, Middle East and Africa  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  301
Asia Pacific . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  301

  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 301
By Email  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 301

North and Latin America, Europe, Middle East and Africa . . . . . . . . .  301
Before you call  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 302
Maintenance Upgrades  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 302
Feedback . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 302
vii  



INTRODUCTION
Congratulations on your purchase of Teamstudio® software.

You can use the Teamstudio tools for IBM Lotus Notes® and Domino® application 
development individually or together.

Download the Teamstudio Installation Guide for instructions on installing and 
removing your Teamstudio tools.

Introduction
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ABOUT THIS BOOK
About This Book

Here’s what you’ll find in this book:

Chapter Description

Chapter 1: Introduction • About this book

Chapter 2: Analyzer • Using Analyzer

• The Analysis Output Database

• The Audit Function

• Analyzer’s Audit Filters

• Auditor Filters for Advanced Users

Chapter 3: CIAO! • Using CIAO! Client

• Building Promotion Paths

• Administering CIAO!

Chapter 4: Configurator • Using Configurator

• Viewing the Configurator Output Log

• Building Configurable Database 
Designs

Chapter 5: Delta • Introduction

• Comparing Elements or Documents

• Sharing Design Changes through 
Merging

• Creating Difference Reports
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INTRODUCTION
Refer to the  Teamstudio Installation Guide for instructions on installing and 
removing your Teamstudio tools.

Once you install the tools you want, read the relevant chapter(s) of this manual to 
learn how to use those tools.

Remember, if you need help, we are just a phone call away. Technical Support is 
provided free of charge for the life of the then-current Maintenance Agreement.

We welcome your feedback! Tell us what you like and dislike about our products. 
Tell us what new features or new products you want to see. That way we can 
continually improve our product, and help you achieve your development goals. 

Chapter 6: Design Manager • Introduction

• Building a Library You Can Share

• Organizing a Library

• Working with Databases and Libraries

• Using Other Tools from Design 
Manager

Chapter 7: Profiler • Using Profiler Client

• Using Profiler Server

• Troubleshooting

Chapter 8: Undo • Using Undo

Chapter 9: Validator • Working with Validator

Chapter 10: Contacting Teamstudio How to contact Teamstudio

Appendix A: ACL Settings List of user Access Level Privileges

Chapter Description
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ABOUT THIS BOOK
Please send us your feedback via techsupport@teamstudio.com.

Thank you for using Teamstudio products!
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TEAMSTUDIO ANALYZER
Introduction

Congratulations on your purchase of Teamstudio Analyzer!

Download the Teamstudio Installation Guide for instructions on installing and 
removing your Teamstudio tools.

You can test, debug and document your database design using Teamstudio 
Analyzer. Analyzer highlights functional dependencies within the design, verifies 
compliance with design standards, and uncovers compatibility issues before an 
upgrade.

How does Analyzer work?

• It reads the design of your Notes database or template. 

• It analyzes this design.

• It builds a separate Notes database that represents the design. 

The new database contains a document for each design element (such as a form, 
view, subform or field). Each document contains the fields that represent the 
properties or attributes of the related design element.

Analyzer can audit your design by testing it against a pre-defined set of criteria 
called filters. The Analyzer audit function identifies design elements that match the 
filter criteria and writes these audit results to an output database. This audit testing 
helps flag standards violations and potential performance problems for further 
review.

Teamstudio Analyzer
Teamstudio  User Guide – 5
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USING ANALYZER
Using Analyzer

Starting Analyzer

To start Analyzer

1. In Designer, open the database you want to analyze.

2. Click the Analyzer button on the toolbar.

You see the Teamstudio Analyzer window.

3. On the Teamstudio Analyzer tab, enter the server name and file name of the analysis 
output database that will store the analysis of your database design, or optionally create 
a new database by selecting the Create new Database check box and filling in the new 
database title, template server and template.

When you click OK, Analyzer examines all design elements and stores the results in 
the database you have specified. See “Analyzing the Database Design,” on page 7, for 
more information.

You can use the Design Notes tab to tell Analyzer which design elements you want to 
analyze. See “Using the Design Notes Tab,” on page 16, for more information.

4. On the Audit tab, enable Auditor which tests your design elements against a pre-
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TEAMSTUDIO ANALYZER
defined set of filters. 

See “Auditing a Design,” on page 12 for more information about the Audit function.

Typically, there is one analysis output database and one audit output database for 
each project. There may be a number of different database designs represented in 
each output database.You may organize the output databases differently.

Analyzing the Database Design

The server and file name that you specified on the Teamstudio Analyzer tab tell 
Analyzer where to store the output from the analysis of your database design.

Tip Design analysis databases become huge if they contain information 
about several database designs. If you select a large number of design 
elements for review by an audit run, the audit output database can also 
become quite large. Consider using more than one output database for 
analysis and/or audit runs, and decide in advance how to split design 
information among different output databases.
Teamstudio  User Guide – 7



USING ANALYZER
Defining the Analysis Output Database

You can either create a new analysis output database or select an existing one.

Creating a new analysis output database

Analyzer will create the output database based on the template you specify. 

To create a new analysis output database

1. Check the Create new Database check box.

2. Select a Server for the output database.

3. Enter a File name for the output database.

4. Optionally, select a Directory for the output databse to reside in.

5. Enter a Title for the new analysis output database. 

6. Select the template Server from the dropdown.

7. Select the Template you want from the dropdown, or click the folder to browse your 
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TEAMSTUDIO ANALYZER
computer to find a file.

8. Click OK.

Selecting an existing analysis output database

If you select an existing output database, Analyzer adds its analysis of the selected 
database to that file.

To select an existing analysis output database

1. Click the File dropdown to select the analysis output database you want.

Note The analysis database and the audit output database are two separate 
databases. You create the audit output database from the Audit tab.
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USING ANALYZER
2. Click OK to run the Analysis.

Note The Select Analysis Database 
window shows only those 
databases based on the 
DEANTemplate.

If the database you want does 
not display, but you know it 
exists, here’s what to do:

1. Open the database in Notes.

2. Click Inherit design from 
template (shown in the oval) on 
the Design tab in Database 
Properties. 

3. Enter DEANTemplate into the 
Template name field.

Note Analyzer checks to make sure you have delete documents access set in the 
access control list (ACL) of the analysis database. If you do not have delete 
documents access, Analyzer may not run.

To work around this issue, restart Analyzer and rename the output database.
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TEAMSTUDIO ANALYZER
Controlling Incremental Updates

The first time you run Analyzer against a database, every design element is 
analyzed (unless you excluded some of them on the Design Notes tab). When you 
run Analyzer subsequent times, select the Incremental update check box to 
analyze and update the documents for only those design elements that have changed 
since Analyzer was last run against them.

Clear the Incremental update check box to analyze every design element and 
update every document even if it has not changed. This feature allows you to 
change the title of a database and then update the design documentation and 
propagate the new title into other design elements.
Teamstudio  User Guide – 11



USING ANALYZER
Auditing a Design

On the Audit tab, you can select the Enable Auditor check box to have Analyzer 
determine whether any of your design elements match a pre-defined set of filters. 
Auditor writes the audit results to an audit output database that you specify. You can 
investigate issues with the design of your database. If you don’t want Analyzer to 
check every design element in your database during the audit, specify individual 
design elements on the Design Notes tab. See “Using the Design Notes Tab,” on 
page 16, for more information.

Each time you run the audit function, Analyzer first examines and updates the 
analysis file for the targeted design. When Analyzer generates audit output 
documents they are linked to the associated documents in the analysis database, 
providing full details of each design element selected by the audit.

To disable Auditor, clear the Enable Auditor check box.
12 – Teamstudio User Guide



TEAMSTUDIO ANALYZER
To select the filter database

You can identify a filter database to use as follows:

1. On the Audit tab, click Choose Filter DB.

2. On the Select Filter Database window, click Select. 

You see the Open/Browse window.

3. Select the Teamstudio Analyzer Filter Database you want.

 

Note Teamstudio installs a sample filter database in your Notes database 
directory.
Teamstudio  User Guide – 13



USING ANALYZER
4. Click Open, then click OK.

5. From the Select Filter Set dropdown, select the filter set you want to run against your 
database.

Rather than run Auditor multiple times against many different filter sets, you should 
combine the filters you want, for example, performance problems and standards 
violations filters, within a class to be processed together.

See “Analyzer’s Filters,” on page 32, for more information on classes and the filter 
database.

Selecting an audit output database

Analyzer Audit places its results in the audit output database you designate.

The audit output database is always based on Teamstudio’s tmslogs.ntf template, 
whether you select an existing output database or create a new one.

To use an existing output database

1. Click Select to display a list of existing databases that are based on the tmslogs.ntf 
template.

2. Select a database.

3. Click Open.
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TEAMSTUDIO ANALYZER
4. To create a new database, enter the server and output database name, including the path.

 The new database is automatically based on the tmslogs.ntf template.

By default, Auditor checks every design element in your database. If you don’t want 
Analyzer to audit every design element, specify individual design elements on the 
Design Notes tab. See “Using the Design Notes Tab,” on page 16, for more 
information.

5. After you select the Enable Auditor check box and a filter set, and you specify the 
output database, begin Analyzing your database.

If you are ready to begin, see “Starting the Analysis,” page 17.

Note You cannot run Auditor without also running Analyzer. When you click OK 
on the Teamstudio Analyzer tab to start Analyzer Audit, the database 
design is also analyzed. The design element subset you selected to Audit 
on the Design Notes tab also applies to Analyzer.

See “Analyzing the Database Design,” on page 7, for more information.
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Using the Design Notes Tab

You can select individual design elements for analysis from the Design Notes tab.

By default, every category and design element is selected, as indicated by the 
checkmarks. All of the categories are children of Everything.

To see a category’s design elements without affecting currently selected or 
deselected items, click the plus sign beside the category.

Here is how Analyzer treats selected categories and selected design elements:

• If you select a design element, Analyzer analyzes it and creates a document for it in the 
output database. If the design element has changed, the new document overwrites the 
existing document. If the design element has not changed, the new document 
overwrites the existing document only if you have cleared the Incremental update 
check box on the Teamstudio Analyzer tab.

• If you select a category, Analyzer checks the category, identifies the elements and 
documents deleted since the last analysis, and moves the Analysis Document to the 
Deleted Documents category in the output database.
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Starting the Analysis
1. After you specify the output database that Analyzer should use, optionally include or 

exclude design elements to analyze and optionally set up Auditor, click OK to start the 
analysis process.

The database design analysis runs before the audit is performed.

You see the Teamstudio Analyzer progress indicator that displays the name of each 
design element as it is processed.

When the analysis is complete, Analyzer opens the analysis output database you 
designated.

2. Expand categories to reveal Analyzer’s design element analysis documents within the 
categories.

Note If you ran an Audit, you must open the Audit output database.
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The Analysis Output Database

Analyzer scans your database, creates a document for each component it finds, and 
organizes the documents using views.
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TEAMSTUDIO ANALYZER
Adding Comments to Design Elements

You can add user data, for example, comments, description, change history, or 
development status to the Analysis documents for major design elements. To view 
the comment area, click the Note tab at the top of an analysis document. 

Double-click the document to make it editable and to display the development 
status options within the Note area.

Items such as buttons and hotspots that Analyzer creates documents for do not have 
a corresponding design element in the application database. Consequently, they are 
difficult to identify reliably from one run to the next. Accordingly, the Note field is 
not included on those documents. Field documents do contain the Note field since 
they rarely change names and aliases.

You can create a separate document to record any additional information about a 
major design element document in the analysis database (for example, a description 
of a design element or maintenance history). You can access a sample document, 
named Additional Documentation Sample, from the Create menu.
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To record additional information about a major design element

1. To create the document, select the design element you want, and select Additional 
Documentation Sample from the Create menu. 

This sample form contains a title field (fspvName_WB) and a rich text body field in 
which to store your information. You can modify these fields to meet your 
organization’s documentation requirements. 
See “Customizing the Template,” on page 26, for more information.

2. Complete and save the form. 

The saved document will display in the All Documents view under the design element 
you created it for.

Deleted Items

Analyzer moves the deleted element data and any user documentation for 
previously deleted design elements. You can find the data under the Deleted Items 
category, in the All Documents view.

You can identify the deleted element and any of its children documents, such as 
fields and buttons, by the Delete icon, a document with a red X through it.

If you no longer need the deleted element data and its documentation, simply delete 

Note The Additional Documentation feature is only available for design elements and 
fields.
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them from the Analysis file using the Delete hierarchy button.

Tip You can drag deleted fields to the Field X-Ref folder to get a field cross 
reference report to show usage of the deleted field. See “Finding all 
References to a Field,” on page 27 for more information.
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Getting Started: Viewing Analysis Information

With the many sorting categories Analyzer provides, you can view the design 
element information you need. So where do you begin? To get started, consider the 
recommended views and actions described in the following table.

Using the Analysis Output Database Views 

Goal What to View in 
the Analysis 
Output Database

What to Do

See where design elements 
are used

• View design 
element 
references

1. Expand the corresponding design 
element category with the left 
navigator, and open the design 
element document. The references 
are listed at the end of the 
document.

2. Go to the Design Aids view 
category and select the 
Dependencies view. This shows all 
design elements with dependencies 
by design element category.

See Last Modified • View all design 
element last 
modified dates

• The Design Aids category has 
several views to show the last 
modified dates.

See Default Access • View the database 
access control list

• In the Analysis category, there 
is a subcategory for ACL 
analysis.

Check view columns for 
consistency

• View columns in 
views

• In the Objects by Name 
category is a view called 
Columns in views that shows 
several settings that can often be 
inconsistent.
22 – Teamstudio User Guide



TEAMSTUDIO ANALYZER
See subroutines in need of 
refactoring

• View the number 
of lines and 
parameters of 
agents

• In the design category, under 
Code and then Script Libraries, 
is a view called Subs that lists 
the number of lines of code and 
the number of variables 
declared. The largest numbers 
are the most complex 
subroutines and could be 
refactored.

See everywhere a field is 
referenced

• Use the Field 
XRef folder

• Simply drag any field document 
(under Forms in Object by 
Name category) and drop it in 
the xRef folder. Then click the 
Add References button. Every 
design element that refers to 
that field will be included in the 
view.

Using the Analysis Output Database Views  (Continued)

Goal What to View in 
the Analysis 
Output Database

What to Do
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Summary of Views

The output database template includes the following groups of views:

View Description

All documents Shows all design elements in all databases in the output database. The view 
is sorted by database title. The hierarchy represents the hierarchy of the 
database design.

The first column in the activity window shows the number (count) of objects 
within each category.

Click the  button to open the database, 

from which the analysis was taken, in a new Notes window.

Design Shows views grouped by the same categories you see in Domino Designer.

By Object Type Also includes the Field X-Ref view that shows where a particular field is 
used.

Analysis Analytical views of design elements.

Design Aids Views that help you understand the design.
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The Analysis Output Database Views

All design elements in all 
databases in the output 
database

Views grouped by the 
same categories you see 
in Domino Designer

Lets you see individual 
elements and set 
elements

Analytical views of design 
elements

Shows 
everywhere a 
particular field is 
used

Views that help you 
understand the design
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Customizing the Template

When Analyzer is installed, it creates a database template file called ivesdean.ntf, 
which has a template name of DEANTemplate. Analyzer uses this template to 
create the analysis output database. The database stores the analysis documents for 
one or more Notes template or database designs.

You can customize the template to create additional views or Notes agents.

To create a template you can customize

1. From Notes, make a new copy of the Teamstudio Analyzer Template (ivesdean.ntf).

2. Open the Database Properties window for the new file. Then click the Design tab.

3. From the Design tab, rename the new template.

4. In the Database Categories box, enter DEANTemplate.

When creating a new output database, you base its design on a template that you 
select from a list of all the templates you have created.

You can add fields to the forms in the output database template. The fields can hold 
information, such as comments, that you add to the database. These additional 
fields are not overwritten when the analysis output is updated.

Tip LotusScript, formula code, Java and JavaScript are always written as rich text. 
This is because plain text fields are limited to around 15K in size by the Notes 
client, and code can be as large as 64K. Since you cannot refer to rich text 
fields in view selection formula, this may at first seem limiting. You can create 
an agent which performs an @Abstract operation on the rich text, converting 
it to plain text, truncating it at some size less than 15K. For example:

FIELD ScriptBegins := 
@If(fflpScripts=””;””;@Abstract([Save]:[Abbrev];14999;””;”fflpScript”))

Caution The content of user-defined fields is only preserved between Analyzer runs 
for design notes and fields.
26 – Teamstudio User Guide



TEAMSTUDIO ANALYZER
Similarly, you can add forms to the output database template to hold any data you 
want to capture. You can create and edit these forms, optionally using formulas and 
scripts that extract data created by Analyzer into your form.

Finding all References to a Field

You can use the Field X-Ref folder to find all references to a particular field name.

To find references to a field

1. Open the Field X-Ref folder.

2. Click the Reset button to remove any documents from the folder.

3. Switch to a view containing the field you want to find references to (for example, 
Objects by Name\Fields).

4. Locate the document representing the field.

5. Drag the field from the view into the Field X-Ref folder.

6. Open the Field X-Ref folder.

7. Click the Add References action button.

Any elements that reference the field will be added to the Field X-Ref folder. The 
folder is categorized by field name.

Caution While a user-defined form is not overwritten when the analysis output is 
updated, the documents created with user-defined forms will only be 
preserved between Analyzer runs for main documents and responses to 
design notes and fields.

Note This structured cross-reference works only for fields.
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The Audit Function

You are often faced with the difficult task of examining a database design to ensure 
it can meet some, unique, criteria. Examples of this are:

• Is the design compatible with the next release of Notes?

• Can the design be moved to another environment?

• Does it meet company standards?

Analyzer’s analysis function helps with these decisions by extensively documenting 
the attributes and contents of a design, and by providing views that help answer 
many of these questions. Sometimes, however, you must examine a combination of 
elements and their attributes to properly answer a question.

The audit function can help by letting you define requirements and then test the 
design of the database or template to make sure it meets the requirements. Many of 
these requirements are reusable, such as standards or common coding errors. Others 
will have a unique temporary nature, such as a special change request or 
compatibility issues raised by upgrades to a new version of Notes. Auditor includes 
some predefined tests that give you a head start on defining typical tests such as 
locating the following:

• Common coding errors

• Potential performance problems

• Violations of typical organizational standards

• Potential application upgrade problems

• Potential Web or O/S compatibility problems
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Auditor Components

Auditor uses several databases to identify the design elements you want to find, as 
described in the following table:

When Auditor runs, it retrieves the filter(s) from the Filters database and scans the 
analysis file looking for design elements that match those filter(s). For each match, 
Auditor creates a document in the audit output database.

Database Description

Filters (based on 
deanfltr.ntf) 

Describes the criteria to use when auditing a design.

Analysis (for example, 
analysis.nsf)

Created by Analyzer when a design is analyzed.

Audit output (for example, 
auditreport.nsf) 

Documents the instances of design elements selected by Auditor 
which match filters.
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Using the Audit Output Database

You can see the database audit results in the Analyzer Auditor\All Output view.

Documents are sorted by database title, the date and time Auditor was run and 
design element categories. Running Audit against the same database at different 
times gives you results grouped for each date and time reported.

Note When you open the Audit output database, you may notice views in the 
navigator pane that do not apply to the Audit function. That is because the 
database is based on Teamstudio’s tmslogs.ntf template, which is a general 
purpose template designed for use with all of our products. Since the Auditor 
only creates documents that appear in its own views, you may ignore the other 
views when using the database for auditing purposes.
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Auditor creates a document in its output database each time it finds a design object 
that matches any of the filters processed during the audit run. A design element can 
appear more than once under its design category since a document is created for 
each filter a design element matches. Expand a design element category to learn 
which design elements matched the filters.

Design elements that matched a filter are divided into severity categories based on 
those defined in the Filters database. In this example, several design elements match 
filters assigned low and medium severity.

If the item selected is a design element (for example, a form), the parent of the 
design element (for example, the database) is listed in the Found In column. If the 
item selected is a component of a design element (for example, a field within a 
form), its host design element is shown under the Found In column. The filter the 
design element matched is listed in the Filter column.
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Analyzer’s Filters

Filters identify design objects you want to focus on. You define filters by specifying 
the attributes and properties that meet your criteria.

Analyzer Filter examples

• Use of @dblookup in a keyword definition (potential performance problem)

• Editable text fields without Help text (violations of organizational standards)

• Non-computed fields ending in “_1” (common coding errors)

• Existence of a certain design element (for example, Help Using, Help About or a 
particular form)

• Use of specific field properties (for example, Date/Time fields that don’t display the 
year with four digits)

Auditor scans the analysis output looking for design objects that match the filter 
criteria and documents each occurrence in the audit output database.

Since most development organizations have their own standards and procedures, 
you may want to add your own filters, modify the severity to match terms and 
criteria you use, and classify filters with terms you normally use. With Auditor, it’s 
easy to customize filters and their attributes to meet your organization’s needs.

You can find the filters and definitions of their attributes (class and severity) in the 
Analyzer Filter database. The Analyzer Filters database included in this release is 
deanfltr.ntf. Prior to Edition 24, it was deanfltr.nsf. This is so the install database 
does not overwrite the filter database currently on your system. If you have 
modified the database in any way, you will not lose any changes or customization. 
However, this means that you must create a new filter database if you want to 
incorporate the bug fixes included with this release. 
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To upgrade your filters database

1. Make a copy of your current Analyzer Filters Database (deanfltr.nsf)

2. Create a new database (File > Database > New) and name it deanfltr.nsf 

3. Select Analyzer Filters Template from the template box.

4. Click Yes when Notes asks if you want to overwrite the existing one. (It's OK; you 
made a copy)

5. Copy all your custom filters into this new database from your old one.

The attribute, Class, groups the same type of filters together. For example, filters 
that identify design techniques that can cause problems when you upgrade to a new 
Notes Release are typically categorized as Release “A” to Release “B” Upgrade 
Issues. Therefore, you can set up a class called Release A to Release B Upgrade or 
simply, Upgrade. Then, when you define a filter that fits this category, you assign it 
to the Upgrade class. At run-time, you tell Auditor which class of filters to use.

The Severity attribute prioritizes the documents stored in the audit output database, 
helping you to systematically review and act on the items selected.

The following sections describe how to work with filters:

• Reviewing filters and their attributes

• Disabling or activating filters

• Editing or creating classes

• Editing or creating severity definitions

• Editing or creating filters
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Reviewing Filters

When you open the Analyzer Filter database, you can review the following:

• Filter Classes—name and description

• The Filters themselves

– by the Class they are assigned to

– by the Design Element they audit

• The Severity Definitions—name and description
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Disabling or Activating Filters

You may decide to stop using a filter, or to use it selectively.

When you disable a filter, Analyzer won’t evaluate the filter when you pick a class 
that the filter belongs to.

You can reactivate a filter later.

To disable or activate a filter

1. From the Analyzer Filter database, click a Filter view, for example, By Class, or By 
Design Element.

2. Click in the left column to select one or more filters to disable.

3. Click Disable Selected Filter(s) or Activate Selected Filter(s).

A green check mark indicates that the filter is active. A red X indicates that the filter is 
disabled.

Remember to activate disabled filters when required.

Editing or Creating Classes

Auditor’s Filter database includes pre-defined filter classes. You can edit the name 
or description of the class and you can create new classes. After you create a class, 
you can add filters to that class. A filter can belong to more than one class.

When you choose a Filter Set on Analyzer’s Audit tab, the classes from the 
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Analyzer Filter database display in the drop-down list.

To edit a class

1. Open the Analyzer Filter database.

2. Click the Admin > Filter Classes view.

3. Double-click an existing Class to open the document.

4. Double-click the document to enter edit mode.

5. Change the Class Name or Class Description to meet your requirements.

6. Save your changes as prompted when you close the document.
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To create a class

1. Open the Analyzer Filter database.

2. Click the Admin > Filter Classes view.

3. Click the Create Class button .

4. Enter the Class Name and Class Description.

The Class Name should be something brief but descriptive since it will be shown in the 
Filter Set selection box at run-time. The Class Definition should explain the use of the 
filters in the Class.

5. Save your changes as prompted when you close the document.
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Editing or Creating Severity Definitions

The Audit database includes pre-defined severity levels that are assigned to each 
filter. Auditor displays data in descending sort order for severity sequence. The 
higher the numeric value, the more important it is to address the issue causing the 
data element’s selection. You can assign severity levels in any numerical range, 
including negative numbers.

The following example shows how you can set up severity codes for filters. You can 
change the name or description of an existing severity level to meet your standards, 
or create an entirely new severity level.

To edit a severity level

1. Open the Analyzer Filter database.

2. Click the Admin > Severity Definitions view.

3. Double-click an existing Severity Definition to open the document.

4. Double-click the document to enter edit mode.

5. Change the Severity Name, Value or Description to meet your requirements.

6. Save your changes as prompted when you close the document.
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To create a severity level

1. Open the Analyzer Filter database.

2. Click the Severity Definitions view.

3. Click Create Severity Definition .

4. Enter the Severity Name, Value and Description.

The higher the severity value, the more important it is to fix the data element identified 
by the filter. You may assign severity levels in any numerical range.

5. Save your changes as prompted when you close the document.
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Editing or Creating Filters

You can change the specifications of an existing filter or create a new filter.

Filter 
description

The element 
the filter is 
focussed on

The property 
to include in 
the validation 
formula

Apply an existing 
filter against 
Parent or 
Children of the 
element in the 
Apply To field.

Continue building 
the filter 
validation formula 
by adding 
conditions
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To create a filter

1. Open the Filter database (deanfltr.nsf).

2. Click the Create Filter action button .

You see a New Filter document.
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3. Define the new filter by completing the following fields:

Field Description

Filter Name The purpose of the filter, for example, agents using Java code.

Filter Active Yes/No indicates whether the filter should be included when one of its 
classes is chosen for processing.

Severity The relative importance of items fitting this criteria.

Filter Class One or more groups (classes) that the filter belongs to

Comment The reason to use the filter, for example, Release A to Release B 
upgrade.

Apply To Click the Apply To dropdown to select the design element you want the 
filter to check. This is the primary focus of the test.

While selecting All lets you create filters that apply to all elements 
within a database design, selecting All Design Elements restricts your 
filter to first-level elements such as page, form or view. It ignores 
(doesn’t include as audit targets) sub-elements such as field, hotspot and 
column.

With the Apply To field chosen, the form expands to show the Evaluate 
Against options, the Property field, and other filter options.

Evaluate Against Select the Property option to include a property in the validation 
formula, or select an option to apply an existing filter against the Parent 
or the Children of the element in the Apply To field.
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The following table describes the buttons on the Filter form:

4. Save your changes as prompted when you close the document.

Property Select the property you want to test. The list generated is based on the 
Apply To field type.

Once you select the property, the form shows options for defining a 
condition to use in the selection step. The condition options you see are 
based on the Apply To and Property fields selected.

Condition Select the appropriate operation to define your test. The operation 
choices depend on the Apply To and Property selections you made 
previously.

For example, select Button for the Apply To design element and Hide 
When Options for the property. To add a Condition, simply select one 
of the operations such as Has one of the following. Then select a 
Compare With value such as Web browsers. To test multiple 
conditions, you click AND or OR to specify the logical operator.

When you have selected the elements of a single condition, click the 
Add Condition button to have the Validation Formula updated to 
include the test just completed.

Button Description

Add Condition Appends the Validation Formula to include the test just defined. 
When more than one formula is specified, the Boolean combination is 
dependent on the option button (also called radio button).

Replace Condition Deletes the entire Validation Formula. Use this button to effectively 
redefine the entire filter, starting with the same design element in the 
Apply To field.

Field Description
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To edit a filter

1. Open the Analyzer Filter database.

2. Double-click an existing filter to open the document.

3. Double-click the document to enter edit mode.

4. Edit the fields you want. 

If your edits require a new validation formula, Auditor automatically generates it when 
you select a property and add or replace a condition.

5. Use the Validation Text field to reverse engineer how a validation formula was 
44 – Teamstudio User Guide



TEAMSTUDIO ANALYZER
created.

6. Save your changes as prompted when you close the document.

Filter Examples

The following table shows examples of filters you can create. Procedures for 
creating them follow the table.

Note  To develop a filter for a different design element, you must create an 
entirely new filter. To modify the Validation Formula, use the Add or 
Replace Condition functions to rebuild the formula.

Filter Example Description

Search for static text You can search your database for instances of a 
particular @Function such as @Do. To do this, create a 
filter that searches for @Do using the TMSRTContains 
formula. Use whole word matching, or the search result 
will include other functions that begin with @Do, such 
as @Doc, @DoChildren and @DocFields.

Search for values included 
within an analysis document

To meet corporate standards, you must find and correct 
all the forms that do not include their name in the 
window title. To do this, you would likely pass the form 
name to the TMSRTContains function using a formula 
such as TMSRTContains( ffrmWinTitle; 0; “Memo” 
), where “Memo” is a particular form’s name. However, 
you want to find all such forms, not just “Memo.”

To search for all such forms, pass the field name that 
contains the title of the form instead of a literal string of 
the form name. You can then apply this filter to all 
forms, not just a particular form.

Use values from the parent One of your company’s standards is that field names 
must start with form aliases. You can create a filter that 
shows all the fields in a document, where field names do 
not start with the alias of the form/subform they reside 
in.
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To create a filter that searches for use of a constant value: “@Do”

1. Open the Auditor Filter database, which is called deanfltr.nsf.

2. Click Create Filter to open the New Filter window.

3. From the New Filter window, enter the following:

4. In the Property field, click the arrow to display the list. Then select the keyword All 
Code (Formula / LS / JavaScript).

5. In the Operation field, select the RT contains option.

6. In the Compare To field, enter @DO.

Field name What to enter or select

Filter Name: Use of @Do in database

Filter Active: Yes

Severity: Medium

Filter Class: Generic Filters

Comment: Look for the use of @Do

Apply To: All
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7. In the Flag field, click the arrow to display the list. 

8. Select Whole Word and click OK.

9. Click Add Condition.

You see the formula in the Validation Formula field.

10. Save the filter and exit.
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To create a filter that searches for values included within an 
analysis document:
Forms with window titles that don’t include the form name or the 
database name

1. Open the Auditor Filter database, which is called deanfltr.nsf.

2. Click Create Filter to open the New Filter window.

3. From the New Filter window, enter the following:

Field name What to enter or select

Filter Name: Form name not used in window title

Filter Active: Yes

Severity: Medium

Filter Class: UI Standards

Comment: Corporate says the name of the form must be 
included in the window title

Apply To: Form
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4. In the Property field, click the arrow to display the list. Then select the keyword 
Window Title Formula and click OK.

5. In the Operation field, select the RT does not contain option.

6. In the Compare field, select Field Value.

7. In the Compare To field, click the arrow to display the list. 

8. Select Name and click OK.

9. Click Add Condition.

You see the formula in the Validation Formula field.

10. Save the filter and exit.
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Auditor Filters for Advanced Users

The Filter wizard creates a validation formula which is a standard Notes formula. 
Advanced users may avoid the limitations of the wizard by manually completing 
the validation formula field.

You should build your filters a step at a time to ensure that each part works correctly 
before you add more to it. Since Auditor requires that you use the design of the 
Analyzer template, you must use fields or alias names from ivesdean.ntf.

Generally, filter validation formulas are standard Notes formulas. Analyzer extends 
these formulas for special purposes with advanced functions.

The following are the advanced filter functions:

• TMSRTContains

• TMSGetParentValue

• TMSGetChildValues( <Form Alias>::<field name> )

• TMSIncludeChildren( UNID; LOGIC )

• TMSSearchAll( Flag; Value )

• TMSIncludeParent( UNID )

• TMSAliasDuplicate/TMSTitleDuplicate( FieldName )

Tip Analyzer Auditor processes documents in the analysis database. This means 
that any time you reference a field name it must be a valid field on a form 
referenced by the Apply To value.

• If you plan to write validation formulas manually, we recommend that you 
familiarize yourself with the design of the Analyzer template 
(ivesdean.ntf). A good starting point is to analyze the Analyzer template.
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TMSRTContains

This function searches the specified rich text field for a value.

TMSRTContains( FieldName ; Flags; Value )

Parameter Meaning Flag Flag Meaning

FieldName This parameter represents the name of a rich 
text field on the current analyzer document.

If Apply To is Agent, then it includes only 
rich text fields that exist on the Agent form in 
the analyzer template.

Or

If this parameter is set to Rich Text, then it 
looks in all rich text fields on the document.

No options

Flag flags This number tells TMSRTContains how to search. 
These flags can be OR’d together

0 Normal

1 Whole Word

2 Case Sensitive

4 Accent Sensitive

8 Wildcards

Value This is the text to search for. It can be a 
quoted string or an unquoted field name. If it 
is a field name, Auditor gets the value to 
search for from that field, so it must be plain 
text.

"<string>"  Quoted text string

or

<fieldname> Unquoted field 
name
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TMSGetParentValue

This function gets a field value from a parent document in the Analyzer database.

TMSGetParentValue( <Form Alias>::<field name> ) 

For example, consider the following:

TMSGetParentValue( CDBP00::fdbpFile )

It returns the file name of the current database.

It can be embedded in the RT formula as follows:

TMSRTContains( Rich Text ; 0; TMSGetParentValue( 
CDBP00::fdbpFile )  )

When checking a filter, GetParentValue is evaluated first and its return value is 
substituted into the formula. Then the rest of the formula is evaluated. This function 
works on any Apply To filter except Database because Database documents do not 
have a parent. 

Parameter Meaning

<Form Alias> This parameter must indicate a parent of the current document (following the 
structure of the Analyzer output).

For example, field cannot be a parent document of a form. However, Form 
can be a parent for a field. Also, the only valid parent for a design element is 
Database (CDBP00).

<field name> This parameter must represent a valid text field on the target document. 
Otherwise, it will fail. The field cannot be a rich text field. If the field is not a 
text field, the value is converted to text.
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TMSGetChildValues( <Form Alias>::<field name> )

This function returns a colon-separated list of field values from child documents in 
the Analyzer database.

Parameter Meaning

<Form Alias> This parameter indicates a form that can be a child of the current document.

For example a column can be a child of a view, but a field cannot.

<field name> This parameter represents a valid text field on the child documents, for 
example, TMSGetChildValues(CCOL00::fcolTitle).  When run against a 
view, the document returns a list of titles for all of the child columns.
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TMSIncludeChildren( UNID; LOGIC )

This function runs the specified filter against all children of the current document 
and combines the results according to the specified logic.

Use the Select filter(s) to evaluate against children button on the filter definition 
form to set up TMSIncludeChildren.

For example:

TMSIncludeChildren(" FA385C79559C18308525690B006479B6";"AND")

Parameter Meaning

UNID This parameter is the UNID of the filter document you will use to run against 
the child documents.

LOGIC Accepts values "AND" and "OR". 

"AND" - result will be true only if the filter evaluates to true for all children. 
"OR" - result will be true if the filter evaluates true for at least one child.
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TMSSearchAll( Flag; Value )

This function is the same as TMSRTContains except it looks in all text and rich 
text fields on a document.

This function returns TRUE or FALSE.

Parameter Meaning Flag Flag Meaning

Flag flags This number tells TMSSearchAll how to search. These 
flags can be OR’d together

0 Normal

1 Whole Word

2 Case Sensitive

4 Accent Sensitive

8 Wildcards

Value This is the text to search for. It can be a 
quoted string or an unquoted field name. If it 
is a field name, Auditor gets the value to 
search for from that field, so it must be plain 
text.

No options
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TMSIncludeParent( UNID )

This function finds the parent document of the document currently being analyzed 
and then runs the specified filter.

This function returns TRUE or FALSE.

TMSAliasDuplicate/TMSTitleDuplicate( FieldName )

This function checks for a duplicate title.

This function returns TRUE or FALSE.

Parameter Meaning

UNID This parameter is the UNID of the Filter document that you will use to run 
against the parent of the current Apply To.

Parameter Meaning

FieldName This parameter is the field name that contains the value that you want to 
check against the list of titles or aliases for that particular class of design 
elements (form/view/agent/etc).
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Introduction

Congratulations on your purchase of Teamstudio CIAO!®

Download the Teamstudio Installation Guide for instructions on installing and 
removing your Teamstudio tools.

Teamstudio CIAO! allows multiple people to work on the design of the same 
database at the same time, without generating save conflicts on the particular design 
elements they are working on. You can use CIAO! client and CIAO! server for 
version control and for promoting versions of your database through the 
development cycle.

If you have used a version control system, for example, Subversion, which is an 
open-source source-control system, you are likely familiar with the principle of 
check-in/out. By checking out design elements, you lock those elements so no one 
else can change them while you are working on them.

CIAO! is made up of the CIAO! client, the CIAO! Config database, and the CIAO! 
Log database. The CIAO! client is where you check in and out the design elements 
you are working with. The CIAO! Config database is a list of databases that CIAO! 
knows about. With the CIAO! Config database, you can configure database 
promotion and version numbering, set up user authority for various CIAO! features, 
and link CIAO! with your issue tracking database. The CIAO! Log database keeps 
the history of every design element checked in.

Teamstudio CIAO!

Note All developers must use CIAO! for design element locking to work 
properly.
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Using CIAO!

To use CIAO!, you first identify a database to put under control.

CIAO! keeps a list of the databases it knows about in its configuration database, the 
CIAO Config database. You need to tell CIAO! where its configuration database is 
before you tell it what databases to watch.

Note The first time you run CIAO!, you are prompted for the serial number and 
key pair you got with your CIAO! license. If you have not entered this 
information, you must do so before you can enable version control for 
your application database.

See the Teamstudio Installation Guide, to complete this step before 
continuing.
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To start CIAO! and put a database under CIAO! control

1. In Designer, open the database.

2. Click the CIAO! button on the toolbar.

If CIAO! cannot find the CIAO! Config database, you see a message asking if you want 
to edit the location of the configuration database.

3. Click Yes to display the Teamstudio CIAO! Client Info window.

4. Click to select the CIAO! uses configuration based on server database resides on 
option to force CIAO! to use the CIAO! Configuration database on the server of the 
target database.

You see a message telling you that CIAO! is not configured to watch the database and 

Note This configuration database must be on the same server as the watched 
database and be called CIAO\CIAOConfig.nsf.
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asking if you want to add it to the list of watched databases.

5. Click Yes to add this database to the list of watched databases. 

You see the Enter Configuration Information window.

The following table describes the configuration fields.

6. Enter the configuration information and click OK.
You see the Enter Version Comment window.

7. Enter a comment, for example, “Initial version under CIAO! control” and click OK.

Field Description

Database The title of the database to watch. The default information is based on the 
database icon you selected on the workspace.

Project You can organize your work into projects. Each project has a set of databases 
within it. If you have previously defined any projects, they appear in the 
drop-down menu in this field. You can create a new project by typing the 
project name into this field.

Log File 
(database)

You can enter the server and path for the log database if you know them. Or 
click Select to browse for a log database. The value in this field will default 
to the last log database you selected. CIAO! can create a new Log database, 
if one does not exist for the specified server and path.
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You see the Version Options window.

8. Enter Initial (or a name of your choice, such as 01000T) into the Version Label field 
(the default is BASELINE) and click OK.

See “Understanding Version Options,” on page 85 for more information on field 
settings. 

Working with Elements

CIAO! allows a team of developers to work on the design of the same database at 
the same time. With CIAO!, each developer effectively locks design elements while 
they are working on them, then unlocks the elements when they have finished. 
While a design element is locked, no other developer using CIAO! can make 
changes to it. This process of locking and unlocking design elements is called 
check-out and check-in.

Note Clicking Cancel puts the database under CAIO! control without a baseline 
version. It does not cancel putting the database under CIAO! control.

Note You can enter only letters and/or numerals in the Version Label field.
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CIAO!-Awareness in Domino Designer 8.5.1

If you are using Domino Designer 8.5.1, you will see database elements with icons 
beside them that represent a CIAO! status as described in the following table:

Icon CIAO! Status

CIAO!-watched

Checked out to me

Checked out to someone else
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When you select a CIAO!-watched element, you’ll see a CIAO! section of the 
Properties tab which displays the element’s owner, checkout comment, date/time 
checked out, and whether or not the element has been changed.

Additionally, by right-clicking within the Database Navigator pane, you display the 
shortcut menu where you can access CIAO! to Undo Check Out, Check In, Check 
Out or Run CIAO!.
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Checking an Element Out

Before you can make changes to the design of a watched database, make sure that 
you check out all the design elements associated with your changes together, so you 
won’t later be stuck waiting to check out elements that someone else is working on.

If you are using Domino Designer 8.5.1 or later, CIAO! prompts you to check an 
element out when you begin to make changes to it.

If you are using Domino Designer versions earlier than 8.5.1 and you make changes 
to an element that is not checked out, CIAO! asks you to check it out when you go 
to save it.

To check design elements out

You check design elements out so no other developers will overwrite your changes. 
You can check design elements out as follows:

1. In Designer, open the database you want to work with.

2. Click the CIAO! button on the toolbar.

3. From CIAO!, select the design elements you want to check out by clicking the design 
element’s name.

Note If you are using Notes 8.5.1 or later, CIAO! automatically recognizes 
which element you have selected in designer and highlights it.
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4. From the CIAO! menu, select Check Out.

Notes • To select multiple design elements in a categorized view, click their 
check boxes, or, if using an uncategorized view, use the SHIFT or 
CTRL key as you click each element.

• You can right-click a design element to display the shortcut menu, and select 
Check Out.

• If a design element is template-linked, you cannot check it out. The template 
to which the element is linked is listed as the owner of the element.

• To allow template-linked elements to be checked out, open the CIAO! 
Configuration database and set the Watch Linked field to Yes. See “Working 
with Templates and Template-linked Elements,” on page 125 for more 
information. 

• Use CTRL+A or Edit > Select All to select all design elements, or, in a 
categorized view, check the box beside the database name.
Teamstudio User Guide – 65



USING CIAO!
You see the Enter Check Out Comment window.

5. Enter a comment describing the changes you are making to the design element.

Note If the An Issue is Required When Checking Out option is checked in 
the CIAO! configuration database for the database you are working on, 
you must assign an issue to the check-out.

If the Mandatory Comment option is checked in the CIAO! 
configuration database for the database you are working on, you must 
enter a comment for the check-out.

Tips • Although you can open a design element, make changes, and only check the 
element out just before saving it, we do not recommended this. Since 
someone else may have checked the element out, made changes and checked 
it back in while you had the element open, you would over-write the other 
person’s changes. Consequently, we strongly recommend that you check an 
element out before you change it.

• If someone has not checked a file in, and you change that file outside of 
CIAO!, then you cannot check the file in.
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To view the design elements checked out

You view design elements checked out so you can see who is working with the 
design elements you are interested in. You can view the design elements checked 
out as follows:

1. In Designer, open the database you want to work with.

2. Click the CIAO! button on the toolbar.

You see the CIAO! window with the name of the open database, the design elements, 
and who has each element checked out.

If you change to the non-categorized view, you can sort the information in columns.

You can sort the list by clicking a column heading. You can also resize the column 
widths by dragging the side of the column header. Double-clicking on the column 
header divider will adjust the column width to best fit the contents.
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To view the check-out comment that someone else provided

You view check-out comments to see the type of changes the current owners of the 
elements say they are making. You can view check-out comments as follows:

1. Select the checked out element.

2. From the View menu, choose Check Out Comment.

Tip You can view an element’s owner, date checked out and comment by 
hovering your mouse pointer over the element.

Note You can edit comments for design elements that you checked out. 
Comments written by other owners are read-only.
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To check out a design element that uses other design elements

You check out a design element that uses other design elements, for example, a 
form and its subforms, so you can make appropriate changes to related elements 
and you can be sure that others do not make changes to them.

1. Select the main design element (for example, the form) by clicking it.

2. Choose Select Dependencies from the Edit menu.
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Any dependent design elements (for example, subforms) are also selected.

3. From the CIAO! menu, choose Check Out.

All selected elements are checked out.

How Using CIAO! Check-out Can Keep Your Changes Safe

While you can view the design of an element someone else has checked out, if you 
try to save any changes, you see a message telling you who the element is checked 
out to.

Note If CIAO! client is on your computer and you are saving a design element 
not checked out to anyone on a CIAO!-watched database, then CIAO! will 
ask you to check out that design element.
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If the database is watched by CIAO! Server Edition, but you do not have CIAO! 
Client Edition installed locally (or you do have CIAO! installed, but it is disabled), 
you see a message telling you that you are not authorized to perform that operation.

Undoing a Check-out

If you have changed a design element, but change your mind, you can undo any 
changes you made by selecting the element in CIAO! and choosing Undo Check 
Out from the CIAO! menu. If CIAO! detects that you made changes to the element 
since the last check-in, you see the following message.

If you click No, the Undo Check-out operation will be canceled, and the element 
will remain checked out to you.

If you click Yes, the element will be restored to its state before the check-out. Any 
changes made to the design element after it was checked out are lost.

If you click Cancel, it is the same as if you clicked No to All.

What if I need an element someone else has checked out?

Occasionally you may find it necessary to check a design element out, even though 
someone else has already checked it out. For example: someone made changes to a 
set of design elements and saved the changes back in the master copy of the 
database. Then, that person left for a two-week vacation without checking those 
changes back in. Unless you had access to that person’s Notes ID file, you could not 
get the changes checked back in to release the locks on the design elements. All 
elements must be checked in before you can save and create a new version of the 
design. See “Making Versions and Restoring to Previous Versions,” on page 83.

The Grab feature allows you to check a design element out, even though it is 
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already checked out by someone else.

You can avoid a difficult situation using the Grab feature. CIAO! lets you grab one 
or more design elements, checking them out to yourself, even though they may be 
checked out to someone else. Use this feature with care, since if the person who had 
the design elements checked out has not saved his or her changes back in the master 
copy of the database, those changes will be lost.

When you grab a design element, CIAO! saves a copy of the checked-out element 
to the CIAO! log database with the Grab comment.

The Grab feature can be restricted from certain users by using a grab-disabled serial 
key. CIAO! comes with a grab-enabled serial key. To get a free grab-disabled key, 
please contact Teamstudio with your product serial number. Another way to restrict 
access to the grab feature is through the CIAO! Config database. See “Assigning 
CIAO! Feature Access,” on page 126 for more information. 
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Checking an Element In

You check an element in to make the element available for check-out. Checking an 
element in saves a copy of the element into the log database. This allows you to roll 
back to that change in the future. Each time you check an element in, CIAO! stores 
the following:

• Issues

• A copy of the element you are checking in

• The comment you attach to it

• A record of who made the check-in operation

• When the check-in operation occurred

Checking in a Single Element

If you entered a check-out comment, and you are only checking in a single element, 
then CIAO! uses this check-out comment as the default. 
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To check a design element in

1. In Designer, open the database you want to work with.

2. Click the CIAO! button on the toolbar.

Design elements that have been changed display in blue by default in the CIAO! main 
window.

3. Select the design elements you want to check in.

4. From the CIAO! menu, choose Check In.

You see the Enter Check In Comment window.

5. Enter the check-in comment and click OK.

Note If you are using Notes 8.5.1 or later, CIAO! automatically recognizes 
which element you have open in designer and highlights it.

Tip You can check in multiple elements at the same time by selecting the 
elements you want to check in, and then choosing Check-in from the 
CIAO! menu. 

If using an uncategorized view, you select multiple elements at once by 
holding down the CTRL or shift key while selecting. To check in all 
elements that are checked out to you, click the Owner column in the 
CIAO! main window. This sorts the display of elements alphabetically by 
owner (that is, who has the element checked out), making it easier to 
select all of the elements that you currently have checked out.

If using a categorized view, you select multiple elements by clicking to 
select their check boxes.
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You may find it convenient to select multiple elements, then check them in, rather 
than check in one at a time. If you are checking in multiple elements, you see the 
following window.

The Keep checked out check box lets you make new versions of the elements, but 
keep them checked out. This is useful if you want to save your changes, yet 
continue working on the same elements.

The Use Checkout Comment check box lets you automatically use the 
checkout comment as the Check In comment.

When checking in multiple elements, including some that you haven’t modified, 
you see a message, offering two additional options: Yes to all and No to all. 

• Click one of these buttons if you do not want to check in each element individually.

Note  If you are checking in multiple elements together, the check-out comment will 
not be displayed as the default check-in comment.

Note The No to all button only applies to elements that have not been 
modified.
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To check in an unchanged design element

You may check in an element, even if you have not changed it. If you have not 
made any changes to the design element since you checked it out, you see a 
message asking if you want to check in a new copy (that is, make a new version).

You see a similar message if you are checking in multiple elements.

• Click Yes, or Yes to all if you want to check in the element and have CIAO! make a 
new version of the element, which is exactly the same as the previous version.

• Click No, or No to all if you if you want to check in the element without making a new 
version.

• Click Cancel to cancel the check-in and to keep the element checked out.

Deleting and Recovering Elements

You can only delete a design element from a watched database if you have the 
element checked out. If you have an element checked out, and you delete it from the 
database design, CIAO! asks you for a comment, as it would for any other change 
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to the database design.

If you are deleting a number of elements at the same time, it can become tedious to 
enter the same comment for each element. 

To delete multiple elements through CIAO!

1. Select the elements you want to delete.

2. Check them all out.

3. From the CIAO! menu, choose Delete.

Once you delete a design element, you no longer see it in the CIAO! main window. 
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To restore a design element that was deleted

You can restore a deleted design element as follows:
1. From the CIAO! menu, select Recover.

You see the Recover window, showing all the design elements that have been deleted.

2. In the Item column, click the element name.

3. Click the Rollback button.

Once the rollback is complete, the element is automatically checked out to you.

Working with Element History

You view an element’s history to see who has been working on an element and what 
changes they have made. From the History window you can also choose to view 
changes between two versions or rollback to a previous version.

To view the history of a design element

You can view the history of a design element as follows:

1. From CIAO!, select the design element you want to view the history of.

2. From the CIAO! View menu, choose History (or double-click the design element).

Items prefixed by a star symbol indicate a version, rather than a check-in.

Tip If the database design is open in Designer when you do the Recover 
operation, Notes does not refresh the view of the design until you close and 
re-open the database. After a Recover operation, always close the database 
design in Notes and open it again before continuing. Press F9 to refresh the 
Notes user interface.
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3. Optionally, check the Show Version Labels box to see versions for your information 
and not for roll back.

If no previous versions of the element have been stored, that is, the element has not 
been checked in, you see the a message telling you that there are no previous versions 
of the element in the log file.

Note You cannot rollback a version. You can only rollback to a previous check-
in operation. A version merely acts like a bookmark or placeholder. When 
you perform a Make Version operation, a new version of this element is 
created only if no previous version exists.
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To copy History text to the clipboard

When you double-click a line item within the History window, you see history 
details. You can copy the info to the clipboard to use elsewhere as follows:

1. Double-click an item in the History window.

You see the Info window.

2. Do one of the following:

– Click Copy Info to copy all of the text to the clipboard.

– Select some text and press Ctrl+C to copy only the selected text to the clipboard.
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To compare two versions of an element

You can compare any two versions of a design element as follows:

1. In the History window, click to select a version and then hold down the CTRL key 
while you click the second version to compare.

2. Click the Delta button.

You see the Delta window.

You see the two elements you chose to compare displayed side-by-side in the Delta 
window. The windows in the two panes are synchronized, so that as you scroll through 
one, the other scrolls with it. You can expand or collapse headings by clicking the plus/
minus signs. To expand the list of elements, click the plus sign in either pane. 
Corresponding elements are always listed side-by-side. Corresponding design elements 
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always have identical names and are of the same type.

An arrow pointing right indicates that the element exists in Database 2 only. If there is 
no corresponding element in Database 2 to an element in Database 1, the corresponding 
line in database 2 is blank. An arrow pointing left indicates that the element exists in 
Database 1 only. To drill down to successively lower levels of detail, continue clicking 
plus signs. To expand everything, press the asterisk key on the numeric keypad.

See “Comparing Elements or Documents,” on page 174, for more information.

To restore a previous version of an element

While working with an element, you may decide it is best to start fresh with a 
previous version of that element. You can restore a previous version of an element 
as follows:

1. To view previous versions of any design element, open CIAO! and double-click the 
name of the design element. 

If the selected element has been checked in at least once, you see the History window.

In the History window, all previous versions of the element are sorted by check-in date. 

2. Select the date of the version you want to restore and click Rollback.

Note You must have the element checked out before you can rollback to a 
previous version. This does not apply to deleted elements, which you cannot 
check out.
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Making Versions and Restoring to Previous Versions

If changes are made accidentally or have been put into production without proper 
testing, you can undo the last set of changes and return quickly to a database design 
that works. If you need to reverse a large number of changes that have been made to 
the database since the last version was made, you may want to restore the entire 
database design.

When your team has finished making changes to a database design, and you are 
ready to make a new release of the database, you can save and assign a new version 
to all of the design elements giving them the same comment at the same time. Then 
you can look at the history of changes made to any one element and see which 
changes were made before a particular release was made, and which changes were 
made after the release.

This is also the time when you increment the version number of your database 
design.

You make a version of a database design so you can have a point release ready for 
QA or for Production, or just a stable roll-back point when you need it.

Note When you first put a database under CIAO! control, CIAO! automatically tries to 
make an initial version of that database.

You can restrict access to the Make Version feature through the CIAO! 
Configuration database. See “Assigning CIAO! Feature Access,” on page 126 for 
more information. 
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You can make a version as follows:

To make a version of a database design

1. In Designer, open the database you want to work with.

2. Click the CIAO! button on the toolbar.

3. Check in all design elements.

4. From the CIAO! File menu, choose Make Version.

You see the Enter Version Comment window.

5. Enter a version comment describing the purpose of the version.

You see the Version Options window.

6. Select the version options you want, and then click OK. See “Understanding Version 
Options,” on page 85 for more information. 

CIAO! adds the new version label entry to the history of each design element.
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Understanding Version Options

The following tables describe the sections of the Version Options window:

Version Options: Version Label and Database

Version Options: Save

Item Description

Version Label No spaces or special characters are allowed except “__” (underscore).

Enter the label, which will become part of the version name. For 
example, entering Sales for version number 1.1.0 results in a release 
number of Sales1.1.0.

This is a required field.

Title The database title for the new version

File Name The filename for the new version.

Extension NTF for template or NSF for database.

Item Description

Database design and 
documents

Select this option to store the data that is in the database along with its 
design. This may be useful if you want to keep test data with this 
version of the database, or if some data documents, such as 
configuration documents, form part of the design.
The default, Database design only, stores only the design, without the 
data.

Database design only Select this option to store only the database design.

Access Control List Select this check box to have CIAO! maintain the access control list 
for the saved database. Otherwise, the default access (author) is 
applied.

Replica ID and 
settings

Select this check box to have CIAO! keep any replication settings you 
have configured.

Store version as ZIP 
file

Select this check box to store the version CIAO! creates in a 
compressed format in the CIAO! Log to save space. If this check box 
is cleared, CIAO! creates your database version as an .nsf or .ntf file, 
uncompressed. 
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Version Options: Version Numbers

Item Description

Release Type Choose the type of release: No Change (to define a baseline or initial 
value for a design), Major, Minor or Point. Consider the three place 
version numbering scheme (1.0.0).

• The left-most position indicates a major version to accommodate 
major feature additions

• The middle position indicates a minor version to accommodate 
minor feature enhancements

• The right-most position indicates a point version for bug fixes

You can customize the terms used for the Release Type options in 
CIAO! Config.

Current Release This is the current release number. CIAO! looks to see if previous 
versions exist in the Log database. If previous versions exist, CIAO! 
uses the latest for the current version number. If no previous version is 
found, CIAO! uses the default value from the CIAO! Config 
document.

You cannot change this field.

Next Release This is the next release number, a field you can change. It was 
recorded in the CIAO! Log as the latest release number.

For the first version number assignment by CIAO!, you can start from 
the beginning (for example, 1.0.0), or you can use the database’s 
current version number (for example, 3.4.0). If no previous version is 
found, CIAO! uses the default value from the CIAO! Config 
document.

Current Client Version Version of Notes Designer

Force Database 
Version

Select this check box to choose a Notes release that is earlier than your 
current client version. This option makes the new version of your 
database compatible with this release.
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If you try to make a version while a design element is still checked out, you see a 
message telling you to check in all design notes. Notes that are checked out tell you 
that a developer may not have finished that work.

Once you check in all design notes, select Make Version again.

When you make a version, and CIAO! cannot find a check-in document in the Log 
database, CIAO! creates one. The reason for this is so you can roll-back to the 
version of the design element as it was when that version was created. You cannot 
perform a roll-back operation on a version record. CIAO! gives this check-in 
operation the same comment given to the version to show that the only purpose of 
the check-in is to create the version.

Restoring the Entire Database Design

In addition to being able to roll back individual design element changes, you can 
also revert to a complete previous version of the database, that is, to a point at 
which a Make Version was performed.

To restore the entire database design, you make a new version, get the version you 
want to bring back from the CIAO! log file and save the version to the path of the 
database you want to overwrite.

Tip If you receive the error message “You are not authorized to perform that 
action” while creating a new version of the database design, this is probably 
caused by a private view or agent in the database design that belongs to 
someone else. Be sure you have rights to all the elements in the database 
before you make a version.
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To roll back the entire database design

You restore a database design as follows:

1. Open the CIAO! Configuration database, which you typically find in the ciao/
ciaoconfig.nsf path.

2. Locate the database document for the database you want to roll the design back on.

3. Select the database document. Then, in the Teamstudio CIAO! > Actions section, click 
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Open CIAO! Log.

4. Once the log database opens, select the Versions view. Then locate and open the version 
document for the version of the database you want to roll back the design of.
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5. Locate the version attachment, which can be in the ntf or zip file format.
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6. For an ntf, right click and save the attachment to your local data directory. For a zip, 
extract it to your local data directory.

7. Click File>Open>Lotus Notes Application and type version.ntf in the File name box.
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8. Once the database opens, open the applications properties by selecting File > 
Application > Properties.
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9. When the properties box opens, click the Design tab.
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10. Give the template a unique template name, for example, the word “version” followed 
by the date and time.
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11. Once you have established this version as a template, open the database you want to roll 
back in CIAO!. Then, check out all design elements.

12. In Designer, open the database you want to roll back. Then replace the design.
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You see the template selection window. 

13. Select the version.ntf template and click replace.

14. Once the replace is complete, open the database you rolled back in Teamstudio CIAO!. 
Then check in the changed items (blue font).
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15. Select the remaining items. Then undo the checkout.

The database has been successfully rolled back to a previous version.

Working with CIAO! Reports

CIAO! provides the following reports: 

• Checkout Activity Report

• Change Report

Checkout Activity Report

You run the Checkout Activity Report to see a list of what elements are currently 
checked out. The report includes elements from all the databases watched by 
CIAO!.
Teamstudio User Guide – 97



USING CIAO!
Since this report shows check-out activity at the time it is run, you can save 
previous report data from one run to the next so you have a history of check-out 
activity.

To create a Checkout Report

1. From the File menu, choose Reports > Create Checkout Report.

You see the Create CIAO! Report window with a default title and the current date and 
time. You can change the report name by changing the text in the Description box.

If you do not have a report database, CIAO! creates one.

2. To create the report, click OK.
You see a message with the report’s location.

To view the checkout report

1. Open the CIAO! Report database.

2. Open the CIAO! Checkout Report view. 

Note All databases listed in the CIAO! Config database are included in the 
report.
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The view is sorted by database name (by default). An alternate view is sorted by project 
and database name.

You see the following information for each design element:

– Item Type

– Name of the design element

– Developer who checked out the element

– Date and time of the check-out

– Comment that the developer included (if any)
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Change Report

To see only those elements that have changed between database versions, view the 
CIAO! Change Report. You can use information in the change report as a source for 
release notes.

To create a change report for a specified database

1. Make a new version of the database if you want the ability to include its most recent 
changes in the change report.

2. From the File menu, choose Reports > Create Change Report.

You see the Create Change Report window.

3. Select the range of versions you want.

a. Select the version label to report up to.

b. Select the starting label to report changes from.

4. Select the output options to use as the report columns.

– Who made the change

– Date/Time of Check-in

– Check-in comment

– Include Difference
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5. Optionally identify the server and path of the report’s output location, or use the default.

6. Click OK to create the report.

You see a message telling you the report has been successfully created.

To view the Change Report

1. Open the reports database.

2. Expand the CIAO Reports section by clicking the plus sign, then click Change List.

3. Open the twistie for the changes you want to see.
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4. Double-click any element to see a detailed change report for it.
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About CIAO! Version Control

With CIAO!, you can store previous versions of design elements and you can 
restore them if needed. Each time you check in a new version of a design element, 
you may enter a comment about and identify an issue related to the changes you 
made. CIAO! keeps a log of all the changes to each design element, so you can 
rollback to any stored version of the design element you want.

When viewing a design element’s change history, you can compare two versions of 
the element, so you can see exactly what has changed from one version to the next.

When the design of a database is ready for release, you can make a new version. 
When you make a version, CIAO! assigns all of the design elements the same date 
and comment, and stores a copy of the database design in the log database.

Promoting a Database

You promote a database to change its release number and move it to the next phase 
of the development cycle. Once an admin has created the promotion step, you can 
promote a database as follows:

To promote a database

1. Open the CIAO! Config database.

2. Locate the database you want to promote and select it.

3. Click Promote Database.

You see the Comment window.
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4. Enter a comment for the promotion and click OK.

You see the promotion log which tells you if the promotion was successful.
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Changing CIAO! Preferences and Views

From the main CIAO! window, you can set preferences for how you want CIAO! to 
appear. You can also make changes to how the views appear.

Changing CIAO! Preferences

You can change the following preferences:

• Enable or disable Tooltips

• Enable or disable case insensitive sorting (when enabled, sort ignores case)

• Hide or show template linked elements

• Define the fonts for normal and modified elements

• Define the font for template-linked elements

• Restore the default font
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To enable/disable Tooltips

You can enable or disable tooltips as follows:

• From the CIAO! menu select Enable Tooltips to add or remove the checkmark from 
the menu item.

To enable/disable case insensitive sorting

You can enable or disable case insensitive sorting as follows:

• From the CIAO! menu select Case Insensitive Sorting to add or remove the 
checkmark from the menu item.

To hide template-linked elements

If you make changes to template-linked elements, the changes could later be 
overwritten in the case of a design refresh or replace. You can change CIAO! 
preferences so that template-linked elements are not displayed in the CIAO! 
window.

• Click File > Preferences > Hide Template Linked Elements

To define fonts

You can define font types, for example, the Normal Font, used in the CIAO! 
window as follows:
1. Click File > Preferences > Normal Font

You see the Font window.

2. Select the font, font style, size, effects and color as needed.

3. Click OK.

To restore the default font

You can restore the default font as follows:

• Click File > Preferences > Restore Default Fonts
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Making changes in the view

Here are some changes you can make to the view:

• Add or remove columns from the view

• Change to a categorized view

To add/remove columns from the view

You can choose which columns to display in the CIAO! window as follows:

1. Click View > Columns to add optional columns to the view, customizing the type of 
information that appears. 

2. Check or uncheck an item to add or remove the column from the view.
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To change to a categorized view

The CIAO! main window default view lets you sort by clicking a column heading. 
CIAO! also has a categorized view of design elements that you can switch to as 
follows: 

• Click View > Categorized View to toggle between the two views.

The check mark beside Categorized View indicates that the Categorized View is 
active. 
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Administering CIAO!

Alternate Ways to Set up CIAO!

CIAO! can be set up so that each location can point to a different configuration 
database. This is convenient for those who are on-the-go.

To locate and/or change the path to your CIAO! Config database

You can change the path to your CIAO! Config database as follows:

1. From the CIAO! View menu, click Client Info.

You see the Teamstudio CIAO! Client Info window.
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2. For each location, select from the Configuration Path dropdown.

Tip CIAO! displays only those databases based on the template CIAOConfig. 
If you know you have a configuration database that does not show up in 
the window, check to make sure that the name of the template on which 
the design is based is CIAOConfig.

If your organization is using CIAO! Server Edition to monitor databases, 
we strongly recommend that you select the same configuration database 
that the copy of CIAO! Server Edition is using. This ensures that any 
databases that you put under control will also be controlled by the 
server.

If in doubt, please check with your CIAO! administrator.
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Enabling or Disabling CIAO! Control of a Database

To remove a database from CIAO! control, you can edit the document for the 
watched database in the CIAO! configuration database.

To edit the document for the watched database

1. Open the CIAO! Config database (usually on the server).

2. In the Go To section, click one of the Promotion Path views, for example, Databases 
by Path.

3. Select the document describing the database you want to remove from CIAO! control, 
and open it for editing.

Note The green check mark in the above figure indicates that the database is 
under CIAO! control. If you remove this database from CIAO! control, the 
icon will change to a red X.
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4. Change the value of the CIAO! Watch Active field from Yes to No to mark the 
database as no longer under CIAO! control.

To put a database under CIAO! control

You put a database under CIAO! control so CIAO! can watch the database, keep 
track of and report on changes, and allow check-in and check-out of elements to 
keep multiple users from modifying the same elements at the same time.

You can put a database under CIAO! control as follows:

1. In Designer, open the database you want to work with.

2. Click the CIAO! button on the toolbar.

You see a message telling you that CIAO! is not configured to watch that database and 

Note Once you remove the watched database from CIAO! control, check-in/
check-out will no longer work for this database. Any developer can make 
changes to any design elements.

You are not removing the history of the database. This remains in the 
CIAO! log database. You can also access the history if you haven’t deleted 
it from the log database.
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asking if you want to add it to the list of watched databases.

3. Click Yes.

You see the Enter Configuration Information window.

4. Enter the configuration information and click OK.

The following table describes the configuration fields.

Field Description

Database The title of the database to watch. The default information is based on the 
database icon you selected on the workspace.

Project You can organize your work into projects. Each project has a set of databases 
within it. If you have previously defined any projects, they appear in the 
drop-down menu in this field. You can create a new project by typing the 
project name into this field.

Log 
Database

You enter the server and path for the log database or click Select to browse 
for an existing log database. CIAO! creates a new Log database, if one does 
not exist for the specified server and path.
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You see the Enter Version Comment window.

5. Enter a comment, for example, “This is the initial version under CIAO! control” and 
click OK.

You see the Version Options window.

6. Enter Initial (or a name of your choice, such as 01.00.00) into the Version Label field 
(the default is BASELINE) and click OK.

See “Understanding Version Options,” on page 85 for more information on field 

Note Clicking Cancel puts the database under CAIO! control without a 
baseline version. It does not cancel putting the database under CIAO! 
control.
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settings. 

About CIAO! Client and Server

There are two components of CIAO!. The CIAO! Client Edition is installed on each 
developer’s workstation, and allows an individual developer to participate in check-
in, check-out and versioning. CIAO! Client’s security features can prevent 
unauthorized access to the configuration database and to CIAO! features such as 
Make Version and Grab.

You can optionally install Teamstudio CIAO! Server Edition onto each Domino 
server used in the development process. CIAO! Server Edition ensures that only 
users running CIAO! Client Edition who have the appropriate design element(s) 
checked out can make design changes. Teamstudio CIAO! Server Edition provides 
an optional, added level of security beyond using Teamstudio CIAO! Client Edition 
alone.

Configuring CIAO! to Watch Documents

You can watch documents using CIAO!. You configure watching documents on a 
per-database basis. Examples of documents you may want to watch include those 
with configuration information or website content. Typically, you don’t watch 
documents for production applications.

To enable document watching

1. Open the CIAO! Config database and find the entry for the database you want.

2. Open the configuration database entry for the database.

3. Click the Watch tab.

4. Set the Watch Documents option to Yes.

CIAO! will then watch any document that contains the $TMSTitle field. This field is of 
type Text, and contains the text you want to use to reference this document. These 
documents appear in the CIAO! user interface as type Document, with the title set to 
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the value of $TMSTitle.

You can then check Documents in and out as usual.

In the following example, the $TMSTitle field was added to a single document in the 
database, and the value This is a document was entered into that field:

Note To stop watching a document, check it out and remove its $TMSTitle 
field.
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Working with Issue Tracking

It may be important to associate your changes to elements to issues in your issue 
tracking database. When you check in or out an element you can note the issue you 
were working on.

To select issues by view

You can select a view for displaying issues as follows:

1. On the Issues tab of the CIAO! Configuration page, select an Issue Database Server.

2. Click the Select by View radio button.

You see the Issue View field and the Select View button.

3. Click the Select View button.
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You see the Select View window.

4. Select the view you want for displaying issues.

5. Click OK.

Note The first two columns of the view must be of type text. The first column is 
for the issue number and the second column is for the issue description.
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To select issues by formula

If the issue tracking database is very large or does not have a view relevant to your 
work, you can use a formula to determine issues to select from.

1. From the Issues tab of the CIAO! Configuration page, click the Select by Formula 
radio button.

2. In the Issue Formula field, enter a Notes selection formula.

The following is an example of an issue selection formula:

3. In the Issue Number field, enter the name of the field (in the issue tracking database) 
that identifies the issue.

This sets the field populating the Issue Selection window which you see when you are 
assigning check-ins and check-outs to issues. This field must be data type text.

4. In the Issue Description field, enter the name of the field (in the issue tracking 
database) that provides a description of the issue. 

This sets the field populating the Issue Selection window which you see when you are 

Formula 
Example

If you have a field called Assignee in your issue tracking database, you 
might only want to display issues that relate to the current user 
working on the current application. The following formula will do this:

Product=”app.ntf”|@username=AssignedTo

Note: This assumes that your issue db contains a field called 
“Product” which contains the application file name and a field called 
“AssignedTo” which contains a canonical username.
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assigning check-ins and check-outs to issues. This field must be data type text.

Requiring an Issue to Check In/Out an Element

At the bottom of the CIAO! Database Configuration page there are two checkboxes:

• An Issue is Required When Checking In

• An issue is Required When Checking Out

When you check either of these options, CIAO! requires you to select an issue to 
associate with your check-in or check-out.You can select from a list based on a 
formula or based on a view in the issue database.

Configuring an Issue Tracking Database in CIAO!

You can assign each of your databases to an issue tracking database in your CIAO! 
Config database.

To set or change the Issue Tracking Server and Path

You set the issue tracking database you want CIAO! to link to in the CIAO! Config 
database. Set the issue tracking server and path as follows:

1. From the CIAO! Config database, open a database configuration document for editing.

2. Click the Issues tab.
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3. In the Issue Database Server field, enter the name of the server where the issue 
tracking database is stored.

4. In the Issue Database Path field, enter the complete pathname of the issue tracking 
database or click the Select Database button to browse for the database.

Understanding CIAO! Config Information

You access a CIAO! Configuration document by double-clicking an entry within 
the CIAO! Config database. You can configure items in the following categories 
from the CIAO! Config document:

Category Description

Basics Database Title, Database Server, Database Path, Project, CIAO! Watch 
Active, Log Server, Log Path

Watch Watch Documents, Watch Template Linked Elements, CIAO! Owner 
in Note Comment, Mandatory Comments

Authority Add, Check Out, Check In, Delete, Grab, Make Version

Issues Copy Issue Settings, Issue Database Server, Issue Database Path, Issue 
Selection, Issue View, Issue Required

Versioning Custom Version Label Settings

Advanced DBID (the database ID of the watched database), Log Key
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Configuring the Basics

You can configure the following from the Basics tab of the CIAO! Config database 
document.

Configuring What CIAO! Watches

You can configure the following from the Watch tab of the CIAO! Config database 
document.

Basics Item Description

Database Title The name assigned to the database.

Database Server The server name of the watched database.

Database Path The path of the watched database.

Project The database’s project name.

Watch Active Whether CIAO! is watching the database (yes) or not (no).

Log Server The name of the log file’s server.

Log Path The path of the log file’s server.

Watch Item Description

Watch Documents Whether CIAO! is watching both design elements and documents.

Watch Template 
Linked Elements

Whether CIAO! is watching template-linked elements.

CIAO! Owner in Note 
Comment

Set to Yes to prepend the check-out owner name in the comment field 
of the Notes Designer activity window. The owner’s name will appear 
like ‘Firstname Lastname ***’ 

where *** marks the end of the CIAO! information. Do not modify 
this!

Mandatory Comments When Mandatory Comments is set to Yes, you can require comments 
for specific operations such as check-in, check-out and delete.
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Authority

As the administrator, you can restrict access from the Authority tab of the CIAO! 
Config database document. You assign the access for each of the items described in 
the table.

Note Leaving a field empty gives everyone access.

Authority Item Description

Add Add design elements to a CIAO-watched database.

Check Out Check out items from a CIAO!-watched database.

Check In Check in items to a CIAO!-watched database.

Delete Delete items from a CIAO!-watched database.

Grab Check out items already checked out by another user.

Make Version Assign a new date, version number, and comment to all items in a 
CIAO-watched database.
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Issues

You can configure CIAO! to link to your issue tracking database from the Issues tab 
of the CIAO! Config database document.

Versioning

You can configure CIAO! to use the release number labels you want from the 
Versioning tab of the CIAO! Config database document.

Issues Item Description

Copy Issue Settings Copy issue settings from another database.

Issue Database Server Server for the Issue database.

Issue Database Path Path and filename of the Issue database.

Issue Selection Method of selecting issues: By Formula or By View.

Issue Formula Formula used to select issues, Issue Number field, Issue Description 
field.

Issue View View used to select issues.

Issue Required An issue can be required on check-out and/or check-in.

Versioning Item Description

Edit Settings Click to open a window where you can edit labels and values that 
make up release numbers.

Position 1 First position of the release number (X.0.0)

Position 2 Second position of the release number (0.X.0)

Position 3 Third position of the release number (0.0.X)

Initial Value Starting value in the position.

Increment Value CIAO! adds to this position’s previous release value when 
assigning the next release number.
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Working with Templates and Template-linked Elements

If a design element inherits its design from a template, CIAO! displays the template 
name in the owner column. CIAO! does not let you check those elements out. To 
change those elements, make changes in the source template.

To allow template-linked elements to be checked out, open the CIAO! 
Configuration database and set the Watch Template Linked Elements field to Yes.

• The default setting No indicates that CIAO! will not watch template-linked elements. In 
this case, CIAO! will not block updates, including normal template design refreshes by 
Notes.

• If the field is set to Yes, CIAO! ignores the template-linkage of the design element. In 
this case, as with any other design element, updates will be blocked unless you have the 
design element checked out.

Note When you set the Watch Template Linked Elements field to Yes, the 
normal Notes Design Refresh operation may override your changes, or 
Notes Design Refreshes may be blocked, depending on the check-out 
status of the element.
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Requiring Comments

You can change the CIAO! Config to require users to enter comments for Checkout, 
Checkin, Delete, Version, or Grab.

Assigning CIAO! Feature Access

You can prevent unauthorized access to CIAO! features such as Make Version and 
Grab through the CIAO! Configuration database.

To assign access

1. From the CIAO! Config database, open the database configuration document for 
editing.

2. Click the Authority tab.
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You see the CIAO! Authority window.

3. Set the access authority for the action you want to assign.

In each case, you see the Select Names window. 

– Add the names or groups of those who will perform each function.

We recommend that you choose from an address book to which everyone has access. 
Otherwise, some people may be locked out because CIAO! cannot resolve the names 
specified.

Note Leaving the field blank allows anyone to perform that function.
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Building Promotion Paths

Building Promotion Paths
If you already have promotion paths in CIAO! Edition 23 or earlier, you can update them to 
use with the current version of CIAO!. You can create multiple promotion paths for each of 
your watched databases. To configure a promotion path document, you create and name the 
promotion path, enter the copy settings, select the promotion options, and the CIAO! 
options; then, save and close the document.

To create and name a promotion path

1. From the CIAO! Config database, select the database document you want to create a 
promotion path for.

2. From the Create menu, click Promotion Path.

You see the Promotion Path document.
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3. Select Yes beside the Active field, if not already selected.

4. In the Description field, enter a name describing the promotion path, for example, 
Dev>QA.

This field cannot be blank and must be unique.

To configure the CIAO! options and save the promotion path

You save a promotion path so you can promote a copy of the database to another 
stage, for example, testing.You can configure the CIAO! options and save the 
promotion path as follows:

1. From the Promotion Path document, click the Watch Target tab.

2. Select Yes for the Watch New Database field, if you want CIAO! to watch the target 
database.

3. In the Destination Configuration Server field, use the selection button, or enter the 
name of the server with the configuration database 

4. In the Destination Configuration Path field, use the selection button, or enter the path 
to the configuration database that you want to monitor the promotion template.

5. In the Destination Log Server field, optionally use the selection button, or enter the 
server name for the log database you want the promoted database to use.
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6. In the Destination Log Path field, use the selection button, or enter the path to the log 
database that you want the promoted database to use.

7. Save and close the document.

You see the new Promotion Path entry in the right pane, under the database to which it 
applies.
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To configure the copy settings for the promotion path

You can configure the copy settings for the promotion path as follows:

1. From the Promotion Path document, select the Basics tab.

2. In the Promote to Server field, select the server you want to promote the database to.

This field cannot be blank.

3. In the Promote to Path field, enter the path that the database is to be promoted to.

This field must be relative to the data directory on the destination server. Leave this 
field blank to specify the data directory itself. If you omit the database name, the 
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current name is used.

4. Enter a Notes selection formula in the Copy Documents field (for example, SELECT 
@ALL) if you have documents that must stay with the database or template.

5. To overwrite old copies of the file being promoted, ensure the Overwrite field is 
checked.

To configure the promotion options of the promotion path

You can configure the promotion options of the promotion path as follows:

1. To require the person promoting the database to enter something into the Promotion 
comments window during promotion, ensure that the Prompt for Comments field is 
checked.

2. In the Notify on failure field, browse to select names from one or more address books 
to designate who to e-mail upon failure of a promotion. 

The promoter (the person who clicks the Promote button) is always notified with a 
status window at the end of the promotion.

Note The blue percent sign (%) at the top of the page indicates that you can 
use replacement macros in this field. Click the blue percent sign to view all 
options. A grey percent sign at the top of the page indicates that you 
cannot use macros in the selected field.

Note Unchecking this setting causes the promotion to fail if the target database 
already exists.
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Working with Promotion Paths

Using CIAO’s auto-promotion feature, you can define a process for promoting 
versions of your database design from one stage of usage to another, typically, from 
the development stage, through one or more testing stages and then into production. 

To add a Make Version step to a promotion path

1. Open the CIAO! Config database.

2. Select the Promotion path document to which you want to add the Make Version step.

3. From the Create menu, click Make Version.

You see the Make Version document.
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4. For the Active field, select Yes if not already selected.

5. In the Description field, enter a name to describe the version, for example, Gold 
Version.

6. To promote without user intervention, uncheck the CIAO should prompt for the 
comment and label option and enter the specified version comment and label, whether 
to bump version numbers, and which options to use: Store As Zip, Save Documents, 
Save ACL or Save Replication Settings).

Leave this option selected if you want CIAO! to prompt you with the Make Version 
window for each promotion.

7. Save and close the document.

You see the new Make Version entry in the right pane, under the database to which it 
applies.

To upgrade existing promotion paths from CIAO! version 23

You can upgrade existing CIAO! promotion paths as follows:

1. Replace or refresh the design of the log or logs

2. Replace or refresh the design of the configuration database to the version 25 template.

3. From the CIAO! Config database, select Actions > Admin > Update Config and 
Logs.
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Log Database Reference

CIAO! stores a history of design element changes and application template releases 
in the Log database. The database can store the history of a single application 
template, a group of templates (a project) or a group of projects.

Each time you check in a design element, CIAO! writes a copy of the design 
element to the log database you have specified in the CIAO! Configuration 
Database.

CIAO! also writes to this log when a new application template is released. In this 
case, CIAO! labels the design elements in the log and creates a new database 
version document.

The history for each element consists of the following:

• Developer who checked in the item or created the application release

• Date and time operation was performed

• Name of the design element as shown in the Notes design pane at the time the item was 
checked in

• Comment written by the developer describing the check-in or version

• Version label

• Version number

• Issues

The history for database version documents consists of the following:

• The ODS version with which the version database was created

• The actual database, stored as an attachment

• The original filename of the attachment before it was renamed to the version.nsf or 
version.zip
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Understanding CIAO! Client and CIAO! Log Entries

The following table describes the types of entries in the CIAO! client and CIAO! 
log databases:

Entry Description

A check-in for a design element. These documents include the body of the Notes 
design document that was checked in by the developer.

A check-in for a design element that has been deleted.

A version of an application template. The application template is an attachment to this 
document.

A design element label. The label does not contain any design information, it simply 
identifies when a release was made. The check-in before the label contains the body of 
the design element.

A Grab of a design element.
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Understanding CIAO Log Views

The following table describes the views in the log database:

View Description

History History of check-ins and versions by design element.

By Application Check-ins and versions by application (database).

By Date Check-ins and versions by day.

By Developer Check-ins and versions made by each developer.

By Project Check-ins and versions by project with most recent history first.

Flat Flat file list of all elements checked in, labeled or versioned.

By Issues Check-ins and versions by issues.

Versions History of versions made.

Release Notes Every check-in or check-out that has an issue number associated with it.
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LOG DATABASE REFERENCE
Understanding CIAO! Log Fields

You can build custom views of the data. The CIAO! Log Database uses field names 
prefixed by the $ character. As such, the field names do not appear in the 
programmer’s pane. The log database uses the following fields:

* Only found in Database Version documents.

Field Description

$CIAOProject Name of the project, taken from the CIAO! configuration 
file.

* $CIAODatabase Name of the database, taken from the CIAO! configuration 
file.

$CIAOType Type of design element, (for example, Agent, Form or 
View).

$CIAOName Name of design element, for elements that support aliases 
this is the first name/alias.

$CIAODisplayName Name of design element, displayed as titled in the History 
view.

$CIAOTime Date and time the design element was checked in.

$CIAOUser Developer’s name.

$CIAOComment Check-in Comment.

* $CIAODBID Unique code identifying each database (hidden).

$CIAOUNID Unique code identifying each design element (hidden).

* $CIAOODSVersion Notes release with which this database is compatible, as 
specified in the Version Options window.

* $CIAOOriginalName The original name of the database before it was renamed to 
version.nsf or version.zip during Make Version.

$CIAO Revision Version number of the element.

* $CIAOVersionNum Pos 1/2/3 Version number values, where 1/2/3 refer to major/minor/
point values.
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Understanding CIAO! Log Forms

The log database uses the following forms:

Moving a Database’s History

To move a database’s history to a different log database

You can move the history of a database under CIAO! control to a different log 
database as follows:

1. Create a new log database.

2. Cut and paste the history documents for this database from the current log database into 
the new one.

3. In the CIAO! configuration database, edit the values of the Log Server and Log Path 
fields to point to the new log database.

About the Log Database ACL

The ACL of the log database should be set so that any CIAO! user (including the 
server, if you are using CIAO! Server Edition) has author-level access or better with 
the Create Documents attribute set. CIAO! creates a document in the log database 
for every check-in operation.

Form Description

CIAOHistory History of a design element checked in.

CIAODeletion History label identifying a design element deleted.

CIAOLabel Version label for a design element.

CIAOVersion Version document for an application template.

Tip Do not edit any of the entries in the Log database using the Notes client.

Because the log database entries contain actual copies of the design 
elements, which the Notes client is not expecting, these will not be written out 
correctly, and will therefore cause problems with CIAO! later on. 

The Log database is intended to be read-only, and should not, under any 
circumstances, be changed using the Notes client.
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TEAMSTUDIO CONFIGURATOR
Using Configurator

Congratulations on your purchase of Teamstudio Configurator!

Download the Teamstudio Installation Guide for instructions on installing and 
removing your Teamstudio tools.

With Configurator, you can easily find and replace text strings in Notes databases. 
Configurator searches design elements and documents, so you can change server or 
domain names in a single pass. You can select a view or write a formula to focus a 
search on a particular set of documents. When searching within a design, you can 
target just the elements or element types you want.

Teamstudio Configurator
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USING CONFIGURATOR
You can also use wild cards in your search criteria.

When viewing the results of a search, you can choose to replace all matches, or to 
review each match, individually confirming whether or not to replace. Configurator 
shows you the search results in context so you can quickly determine if a change is 
appropriate.You decide whether to view search results on-screen or to store them in 
a database to review later.
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TEAMSTUDIO CONFIGURATOR
Getting Started

To start Configurator

1. In Designer, open the database you want to work with.

2. Click the Configurator button on the toolbar, or click Search from the Designer Search 
menu.

You see the Teamstudio Configurator window.
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From the Designer Search button, the Configurator window looks slightly different.

Specifying Where to Search

If you select the Design check box, Configurator can search for occurrences of the 
search text anywhere in the database design. This includes all of the formula code, 
LotusScript, static text on forms, subforms, help\using and help\about documents, 
field help, popups, element titles (for example, form titles and view titles)—in fact 
just about anywhere you can change text.

If you select the Recompile modified design notes check box, then when 
Configurator changes formula and LotusScript code, it checks the syntax and then 
recompiles the code. So if you make a change that causes a syntax error, you must 
fix the code before you can save the element.

   Tip The last few Search and Replace parameter entries for Find what and 
Replace with are saved. Click the arrow to the right of the field to 
quickly select these criteria.

The Find what and Replace with boxes accept a maximum of 254 
characters.
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If a change in source code causes an error, Configurator records that in its log. 
When you click Replace All, and your change causes an error, the original source 
code does not change. When you click Replace, and your change causes an error, 
Configurator gives you the option of saving the original source code or saving the 
source code with the error-causing changes. If you save an element with syntax 
errors, Configurator will not save the compiled (object) code for that element. 
Configurator only saves the object code from an error-free compile.

You use the Documents option to search and replace strings in any fields that 
contain text.

Within the following items, Configurator can Search but cannot Replace:

• Composite Apps

• Wiring properties

• Components

• Outlines

• ACLs

You can specify which documents to include in a search by specifying a selection 
formula (like a selection formula in a view), or by selecting an existing view.

Notes Configurator only changes text found in the field—not the actual field name.
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Specifying Your Selection by Formula or View

You can select documents by formula or by view.

To select documents by formula

• From the Teamstudio Configurator tab, click the Select by: Formula option button.

When you select documents by formula, the default is the formula @ALL, which 
means all documents in the database. For example, you can select all documents that 
were created with the MainTopic form by specifying the formula:

Form = “MainTopic"

To select documents by view

1. From the Teamstudio Configurator tab, click the Select by: view option button. 

You see a box containing a list of views in the database design.

2. Select the view you want.

Specifying Where to Store Configurator Results

When Configurator finishes an action, it displays an on-screen log of the results. If 
you prefer, you can store the logs in a Notes database as a historical record of the 
changes you made using Configurator.
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To store Configurator results in an output database

1. From the Output tab, select Output log to database.

2. Optionally select Use a separate response document for each design element, so that 
you can view a document for each element’s results, rather than a single longer 
document for all results.

3. In the Report Document Title box, enter a title for the report.

4. Click Select to locate a database in which to store the report.

You see only databases based on the reports template. The reports template name is 
TMSLogs, and the file name is tmslogs.ntf. 

– Select an existing database or specify a new database server/pathname. 

Configurator bases the new database on the TMSLogs template and creates the output 
database for you.You can store Configurator report documents for more than one 
database in the same output database.

Tip Each time you run Configurator, whether on the same database or 
different databases, change the report title. This makes it easier to locate 
log reports in the output database.
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Selecting Design Elements

You can select individual design elements for processing using the Design Notes 
tab in the Teamstudio Configurator window.

Select/Deselect design elements using the check box to the left of the desired 
element name. A checkmark indicates selection.

Use a category heading check box to select/deselect all of the elements contained 
within that category.

Select the Everything category to select all design categories and notes. If the 
Everything category is selected, de-selecting a child category or element will 
override (uncheck) the Everything selection.
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Selecting Match Options for Searches

You can select options that further define what qualifies as a match.

Matching Whole Words

If you select the Whole word check box, Configurator matches the search string if 
the matched string is surrounded by spaces or punctuation.

For example, without the Whole word check box selected, replacing the string 
“Heading” with the string “Topic” would have the following results:

“Heading” would be changed to “Topic”

“Headings” would be changed to “Topics”

With the Whole word check box selected, the same search/replace operation would 
have the following results:

“Heading” would be changed to “Topic”

“Headings” would remain as “Headings”
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Matching Accented Characters

If the Accent check box is selected, and the search contains accented characters (for 
example, à ä ç é ë ï ô), Configurator will only match the search string if the 
characters in the matched string have the same accenting.

For example, without the Accent check box selected, replacing the string “Naïve” 
with the string “Innocent” would have the following results:

“Naïve” would be changed to “Innocent”

“Naive” would be changed to “Innocent”

With the Accent check box selected, the same search/replace operation would have 
the following results:

“Naïve” would be changed to “Innocent”

“Naive” would remain as “Naive”
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Matching Case

If the Case check box is selected, a string will only match if the case of the two 
strings matches.

For example, without the Case check box selected, replacing the string “Customer” 
with the string “Client” would have the following results:

“Customer” would be changed to “Client”

“customer” would be changed to “Client”

With the Case check box selected, the same search/replace operation would have 
the following results:

“Customer” would be changed to “Client”

“customer” would remain as “customer”
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Using Wildcards

Select the Use Wildcards check box to perform a wildcard search from the Find 
What field. The * wildcard character lets you search on 0 to n number of characters, 
up to the first space character. The ? wildcard character lets you search on one 
character, up to the first space character.

For example, entering Lotus* to find all instances of words starting with Lotus will 
find:

“LotusScript” and “LotusNotes” but not “Lotus and IBM” (intervening space)

Entering Lotus?otes will find:

“LotusNotes” and “LotusSotes” but not “LotusNootes”

Entering www.ives.* will find all instances of www.ives.com and www.ives.co.uk, 
so that you can replace them with www.teamstudio.com.

Entering Field* will find all instances of FieldA, FieldB and FieldC, so that you can 
replace them with FieldZ.

Using Regular Expressions

A regular expression is a formula for matching strings that follow some pattern. It is 
used to search and manipulate bodies of text based on certain patterns.With regular 
expressions, you can do the following:

• Extract a substring from a string based upon a pattern match.

• Validate data. Test for a pattern within a string. For example, you can test an input 
string to see if an email address pattern, a telephone number pattern, or a credit card 
number pattern occurs within the string.

• Replace text. You can use a regular expression to identify specific text and either 
remove it completely or replace it with other text.
152 – Teamstudio User Guide



TEAMSTUDIO CONFIGURATOR
Position Matching

Position matching involves the use of the ^ and $ to search for the beginning or 
ending of strings. Setting the pattern property to "^LotusScript" will successfully 
match "LotusScript is cool." It will fail to match "I like LotusScript."

Symbol Function Examples

^ Matches the beginning 
of a string.

^abc
Some matches include abc, abcdefg, 
abc123

$ Matches the ending of 
a string.

$abc
Some matches include abc, endsinabc, 
123abc

\b Matches at the position 
between a word 
character (anything 
matched by \w) and a 
non-word character 
(anything matched by 
[^\w] or \W) as well as 
at the start and/or end 
of the string if the first 
and/or last characters 
in the string are word 
characters.

Matches a backspace \u0008 if in a []; 
otherwise matches a word boundary 
(between \w and \W characters). 

.\b matches c in abc

\B Matches at the position 
between two word 
characters (i.e the 
position between 
\w\w) as well as at the 
position between two 
non-word characters 
(i.e. \W\W).

\B.\B matches b in abc
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Literals Matching

Literals include alphanumeric characters, ACSII, octal characters, hexadecimal 
characters, UNICODE, or special escaped characters. To match these special 
characters, we precede them with a "\" in a regular expression.

Symbol Function

\n Matches a new line.

\f Matches a form feed.

\r Matches a carriage return.

\t Matches a horizontal tab.

\v Matches a vertical tab.

\? Matches ?

\* Matches *

\+ Matches +

\. Matches .

\| Matches |

\{ Matches {

\} Matches }

\\ Matches \

\[ Matches [

\] Matches ]

\( Matches (

\) Matches )

\xxx Matches the ASCII character expressed by the octal number xxx

\xdd Matches the ASCII character expressed by the hex number dd

\uxxx Matches the ASCII character expressed by the UNICODE xxxx.
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Character Matching

Character matching enables customized grouping by putting expressions within 
[]braces. A negated character class may be created by placing ^ as the first character 
inside the []. Also, a dash can be used to relate a scope of characters.

For example, the regular expression "[^a-zA-Z0-9]" matches everything except 
alphanumeric characters. In addition, some common character sets are bundled as 
an escape plus a letter.

Symbol Function Examples

[xyz] Match any one 
character enclosed in 
the character set.

a[bB]c
Matches abc, aBc

[^xyz] Match any one 
character not enclosed 
in the character set.

. Match any character 
except \n

a.c
Matches abc, aac, acc, adc, aec

\w Match any word 
character. Equivalent 
to [a-zA-Z_0-9]

\W Match any non-word 
character. Equivalent 
to [^a-zA-Z_0-9]

\d Match any digit. 
Equivalent to [0-9]

\D Match any non-digit. 
Equivalent to [^0-9]

\s Match any space 
character. Equivalent 
to [\t\r\n\v\f]

a\sc
a c

\S Match any non-space 
character. Equivalent 
to [^\t\r\n\v\f]
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Repetition

Repetition allows multiple searches on a clause within the regular expression. By 
using repetition matching, we can specify the number of times an element may be 
repeated in a regular expression.

Symbol Function Examples

? Match zero or one 
occurrences. 
Equivalent to {0,1}. 

ab?c
Matches ac, abc

a\s?b
Matches “ab” or “a b”

* Match zero or more 
occurrences. 
Equivalent to {0,}.

ab*c
Matches ac, abc, abbc, abbbc

+ Match one or more 
occurrences. 
Equivalent to {1,}.

ab+c
Matches abc, abbc, abbbc

{x} Match exactly x 
occurrences of a 
regular expression. 

a{3} \d{4} ab{2}c
Matches Aaa From 10 to 99 abbc

\d{5}
Matches 5 digits.

(x,} where x>=1 Match x or more 
occurrences of a 
regular expression. 

\s{2} 
Matches at least 2 space characters.

{x,y} where x>=1 and 
y>=x

Matches x to y number 
of occurrences of a 
regular expression. 

a{2,4}
Matches aa, aaa, aaaa

\d{2,3}
Matches at least 2 but no more than 3 
digits.
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Alternation and Grouping

Repetition allows multiple searches on a clause within the regular expression. By 
using repetition matching, we can specify the number of times an element may be 
repeated in a regular expression.

Back References

Back references enable the programmer to refer back to a portion of the regular 
expression. This is done by use of parenthesis and the backslash (\) character 
followed by a single digit. The first parenthesis clause is referred by \1, the second 
by \2, etc.

Symbol Function Examples

() Grouping to create a clause. May 
be nested. 

(abc){2}
Matches abcabc

(ab)?(c)
Matches “abc” or “c”

| Alternation combines clauses into 
one regular expression and then 
matches any of the individual 
clauses.

The pipe has the lowest 
precedence of all operators. Use 
grouping to alternate only part of 
the regular expression.

bill|ted
Matches ted, bill

abc(def|xyz)
Matches abcdef, abcxyz

(ab)|(cd)|(ef)
Matches “ab” or “cd” or “ef”

Symbol Function

()\n Matches a clause as numbered by the left parenthesis
“(\w+)\s+1” matches any word that occurs twice in a row, for example, 
“hello hello”
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Telling Configurator What Action to Take

Once you have selected the options, you are ready to select the Action, that is, what 
Configurator is actually going to do.

The actions are:

• Find

• Find All

• Replace All

Find

Click the Find button to locate the first occurrence of the search string in the 
database. Once Configurator finds a match, you can do one of the following:

• Replace that match and move on to the next match

• Skip that match and move on to the next match

• Replace that match and all subsequent matches

• Cancel out of the operation

See “When Configurator Finds a Match,” on page 159, for more information.

Find All

Click the Find All button to have Configurator locate all instances of the search 
match. While the process is running, you can interrupt it by pressing the CTRL key 
while simultaneously pressing the BREAK key (CTRL-BREAK) on your keyboard. 
When the search is finished, you see the Configurator Log, detailing the following:

• Number of notes searched

• Number of matches per element

• Total number of matches found

Configurator makes no replacements when you use Find All.
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Replace All

Click the Replace All button to have Configurator replace all search matches with 
no prompting. While the process is running, you can interrupt it by pressing the 
CTRL key while simultaneously pressing the BREAK key (CTRL-BREAK) on your 
keyboard.

When Configurator Finds a Match

If you’ve used Configurator through Designer’s Search menu, you’ll see the search 
result summary in the search tab at the bottom of the window.

Caution Clicking Replace All will replace all text without prompting.
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You can drill down to the matched item where you can decide what action 
Configurator should take.
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The information you see when Configurator finds a match will vary depending on 
the element type. If the match is in an area that can use the preview pane, for 
example, a visual element or static text, then you see the split window with the 
match highlighted.
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For simple text and code matches, you see the matched text in context as shown.

The window title reflects the name of the Note where the match is found.

From this window, you can do the following:

• Click Find Next to locate the next match, which may be within the same dialog box.

• Click Replace to replace the highlighted match text, and locate the next match.

• Click Skip Note to continue to the next element or document (if changes have been 
made, a dialog box displays asking if you want to save the changes, before continuing 
to the next element or document).

• Click Replace All to replace the current selection, and automatically replace all other 
matches in the database.

• Click Cancel to cancel the search.

Tip To make a manual change to view names, edit in the 
highlighted area and click Find Next.
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If the match occurs in static text on a form, subform or in help\using or help\about, 
the text appears in context on the form or subform in the top half, and an editable 
version of the text appears in the bottom half of the window.

You can click the Replace button to replace the highlighted text and move on to the 
next match, or you can manually edit any of the text you see in the lower half of the 
window and then click Find Next.

Note If you make a change, and click Skip Note, Configurator prompts you to save 
or discard changes made to that point for the element being processed, or to 
cancel the action. Clicking Cancel will only cancel the Skip Note operation. 
Processing will continue with the next element found to match, if any.
Teamstudio User Guide – 163



USING CONFIGURATOR
Once Configurator finds all of the matches in a particular design element (and you 
have not clicked Skip Note to stop processing that element), if you have made any 
changes (either replacements or manual edits), Configurator asks if you want to 
save the element before continuing.

You click one of the following:

Yes Configurator saves the changes you made within this design element and continues to 
the next match.

No Configurator discards any changes you made in this design element, and continues to 
the next match.

Cancel Configurator discards any changes you made to this design element, and restarts the 
search at the beginning of the same element. This gives you a chance to undo any 
changes you have made to this design element and start over.
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Viewing the Configurator Output Log

As matches are found in the target database, Configurator stores the following 
information in an on-screen log as well as in the optional output database:

• Where the match was found

• What action was taken

• A summary count of matches and/or replacements per element

• Any skipped notes

• If the changes made were cancelled

• The total number of notes searched

• The total number of matches

• The total number of replacements

• Any errors that occurred during the action

See “Specifying Where to Store Configurator Results,” on page 146 for more 
information on the output database.

The following is an example of the on-screen output log.

When the search/replace action is complete, you can scroll through this log. You 
can also copy this log to the clipboard, by clicking the Copy Log button. This 
allows you to create a full report of the changes that have been made in another 
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application, such as Notepad or Microsoft Word.

Before you run Configurator, you can optionally create a database to store the 
output log. The information you see in the output log database and in the on-screen 
log are identical.

The following is an example of the contents of a Configurator output log.

Where a match has been found in static text, the text is divided into blocks, each of 
which represents a block of text in the same font face. Each block has a separate 
entry in the log.

Action performed: Find

Matching: All

Searching: Design

Searching Discussion - Notes & Web (R5.0) on 
Local (discsw50.ntf).

Find: 'Topic'

Replace with 'Subject'

Form 
(IntProfileInstructions)|(IntProfileInstructions)

  Text

    Found 3. Replaced 2.

    Found 1. Replaced 1.

    Found 1. Replaced 1.

    Rest of element was skipped. *Changes
   abandoned*

  Total Found on note: 6

  Total Replaced on note: 0

Total Notes Searched: 2

Grand total found: 6

Grand total replaced: 0

The log starts by providing a note of the 
database against which Configurator was run. 
It also specifies the search and replace texts.

For each element in which a match was found, 
the log records the:

• The element name

• The lower level item in which the match 
was found (for example, the Topic 
column)

• A count of the number of matches

• A record of the action taken

The action may be Replaced N where N is 0 
or more, corresponding to the number of 
straight replacements, or Manually edited, 
which indicates that the user changed 
something other than just replacing the 
matched text.
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Building Configurable Database Designs

When you build configurable texts into your database design, you can use 
Configurator to make quick changes, tailoring your application to meet individual 
customer needs.

Say, for example, you’re building a sales force automation system you will sell to a 
number of clients.You may have a field that captures the status of an account. When 
you define the static text for the field label as “[#Status#]”, you can use 
Configurator to easily customize this static text for a client, who, for example, 
prefers the text label “Phase”.

Similarly, the keyword list behind the Status field may consist of the following 
entries: “[#Prospect#]”; “[#Customer#]”; and “[#Ex-customer#]”, which you can 
easily re-configure to meet your customer’s requirements.

You can even make your application entirely configurable by creating completely 
generalized keyword lists that define list members as “[#Item1#]”; “[#Item2#]”, 
and so on.

Using Configurator you can build a form where every piece of static text is 
configurable. Your application runs significantly more quickly and efficiently when 
you use Configurator than when you use run-time @DBLookup commands.
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TEAMSTUDIO DELTA
Introduction

Congratulations on your purchase of Teamstudio Delta!

Download the Teamstudio Installation Guide for instructions on installing and 
removing your Teamstudio tools.

Teamstudio Delta is a comparison and reporting tool that compares the following:

• Two versions of a Notes database design

• Two versions of the same design element

• Design or documents within the same database

• Documents from two different versions of the same or different database

Delta can help you keep up with IBM Lotus Notes template updates made for each 
new release. If you changed your copy of the standard Notes e-mail template for 
one release and your organization is upgrading to a new release, you need to find 
out the following:

• The differences between the templates in those two releases of Notes. 

• The differences between the template you are using (that includes your customizations) 
and the standard template you started with.

With this information you can decide whether to re-apply your customizations to 
the updated standard template or to integrate the upgrades made to the new template 
into your customized version.

Teamstudio Delta
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How Delta Works

Teamstudio Delta compares two database designs and shows you what is different 
between them. If you ran Delta against an earlier Notes release e-mail template and 
the later Notes release e-mail template, you would quickly discover a number of 
changes.

Without the help of Delta, finding these changes would take hours. 

Delta makes it easy to compare visual elements, such as two forms. You can 
examine two forms, and instead of seeing the code in text form, you see a visual 
representation of each design element, side-by-side. As you scroll left, right, up, 
and down, the two preview panes stay in sync making it easy to compare the two 
forms.
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Using Delta

You can begin using Delta as follows:

To compare design elements within a single database

1. In Designer, open one of the databases you want to compare.

2. Click the Delta button on the toolbar. 

You see the Delta window, with both the Database 1 and Database 2 fields populated 
with the file name of the database you have open.

You can compare two different databases or compare one database with itself.

3. In the Delta window, select the database whose design elements you want to compare, 

Note If you start Delta without a database open, Delta starts with the 
databases last compared in the Database 1 and Database 2 File name 
fields. However, if you have not used Delta before, the program starts 
with both database fields blank.
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if not already selected.

4. In the Options area, select Compare Design.

5. Click Compare.

You see the following message.

6. Click Yes.

Delta’s main window opens when the Delta comparison process is complete.

The design of the databases is represented hierarchically.

7. Uncheck Hide Identical Objects.
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The windows in the two panes are synchronized, so that as you scroll through one, 
the other scrolls with it. The display always starts with all headings collapsed. To 
expand/collapse the list of elements, click the plus or minus sign beside a heading in 
either pane. Corresponding elements are always listed side-by-side. Corresponding 
design elements always have identical names and are of the same type.

An arrow pointing right indicates that the element exists in Database 2 only. If there 
is no corresponding element in Database 2 to an element in Database 1, the 
corresponding line in database 2 is blank. An arrow pointing left indicates that the 
element exists in Database 1 only.

To drill down to successively lower levels of detail, continue clicking plus signs. To 
expand everything, press the asterisk key on the numeric keypad.
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Comparing Elements or Documents

To compare items in two different databases

1. In the Delta window, select the two different databases whose elements or documents 
you want to compare, if not already selected.

2. In the Options area, select Compare Design or Compare Data.
If you selected Compare Design, move ahead to step 3.

If you selected Compare Data, Delta requires you to specify a view that will display 
the data sorted on a common field.

a. Beside the View box, click Select to open the Select Data View window.

b. Expand the View dropdown.

c. Select a view that categorizes documents on fields that will match documents 
across the two databases, making it easy for you to locate documents and show 
their differences. 

d. Click OK.

Tip • Select a familiar view to make it easier to locate the data documents of 
interest.
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3. Click compare.

Delta’s main window opens when the Delta comparison process is complete.

Each database is represented in a pane, with Database 1 on the left and Database 2 on 
the right. The design of the databases is represented hierarchically.

When comparing documents, the documents are listed in the sequence determined by 
the view you selected. They may be represented hierarchically, for example, with parent 
or main documents preceding their descendant. Documents are identified with a note 
icon .

The windows in the two panes are synchronized, so that as you scroll through one, the 
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other scrolls with it. To expand the list, click the plus sign in either pane. Corresponding 
items are always listed side-by-side, have identical names, and are of the same type.

An arrow pointing right indicates that the item exists in Database 2 only. If there is no 
corresponding item in Database 2 to an item in Database 1, the corresponding line in 
database 2 is blank. An arrow pointing left indicates that the element exists in 
Database 1 only.

4. To drill down to successively lower levels of detail, continue clicking plus signs.
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About Difference Symbols

A symbol displays beside each element or document compared using Delta.

Mark Description

Blue checkmark Items are identical. Clear the Hide Identical check box to show 
identical items.

Checkmark with 
an asterisk

There are differences among child  documents. This only 
appears when comparing data.

Red X Items are different from each other.

Green left arrow Item exists in Database 1 (on the left) but not in Database 2 (on 
the right).

Blue right arrow Item exists in Database 2 (on the right) but not in Database 1 
(on the left)

Gray diamond Identifies a save conflict for two corresponding items.
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Delta Options

You use the check boxes in the lower left corner of the main window to filter the 
comparison results:

Viewing Design Element Descriptions

You can view descriptions of the various parts of the design using Delta’s context-
sensitive help.

For example, if you are not sure what the $Flags item within a form means, 

Check box Description

Select Hide Identical Objects (the default) to list only 
elements and documents that are different in the two panes. 
Clear this check box to see the complete database design—
elements and documents that are identical and elements and 
documents that are different.

Select Smart Filter to hide or filter information that is of no 
practical interest when comparing the database designs.

For example, an Agent stores information about the last time it 
was run. This is likely to be different between two different 
copies of a database, but does not really mean that there are 
differences in the design. With Smart Filter selected, Delta 
ignores that attribute.

Select Hide Unique Notes to hide notes that exist in only one 
of the databases you are comparing.
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right-click the item and choose What’s This from the shortcut menu.

You see a window with the item description.
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Hovering your cursor over a design element also gives you the item description in a 
ToolTip popup.

To toggle the ToolTips feature

Click Preferences > Enable ToolTips.

Note Delta displays the first 128 characters of the help topic. To view the entire 
topic, choose What’s This on the shortcut menu.
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Viewing Differences

Once you have determined which corresponding items are different, you can 
compare them to learn how they differ.

To compare and display the differences between two individual items, double-click 
the item in either pane. Alternatively, right-click the item and choose Differences 
from the shortcut menu.
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The Show Differences window displays the attributes of the two corresponding 
design elements side-by-side. The element from Database 1 is in the left pane and 
the element from Database 2 is in the right pane.

In this example, we compared the Database information for each of the two 
databases to see the differences between each database’s general attributes.

You use Delta’s Differences feature to learn the differences in the structure of two 
design elements or the differences in two fields, or code, such as LotusScript. These 
types of differences display as text. See “Viewing Differences,” on page 181, for 
more information.

Note Data stored in a format other than text, for example, binary data, is converted 
to text for the Delta comparison. In the example, the field Database ID’s 
original binary data was converted to hexadecimal data. Some fields require 
special interpretation by Delta. In the example, the two lines that follow the 
Flag field were Delta’s interpretation of the flag values.

If you select a design element that exists in one database but does not exist in 
the other, the attributes of the existing element display in the appropriate pane 
and the other pane is empty.
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You can also show a visual preview of differences when the design element is a 
form, subform, page or other visual design element.

When you compare two elements that contain code, such as LotusScript, you see 
that programming code in the Show Differences window.

Tip See “Setting Delta Preferences,” on page 193, if you want to change how the 
Delta Show Differences window displays fonts and white space.

Note The Differences function can only be used with two corresponding, side-by-side 
items.

To learn the differences between two items that do not correspond, try 
Matching them first (See “Matching Elements or Documents,” on page 188). If 
the two items are too dissimilar to be matched, use Compare to see their 
differences (See “When You Can’t Match Elements or Documents,” on page 
190).
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Color-coded Text

The Show Differences window displays differences as color-coded text.

Locating Differences within the Show Differences Window

Use these two buttons to locate differences.

Hiding Identical Properties

Text Color Description

Black Corresponding lines of text in both databases are identical.

Red Corresponding lines of text in both databases are different.

Green Line of text appears in Database 1 (on left) but not in Database 2.

Blue Line of text appears in Database 2 (on right) but not in Database 1.

Note You can customize Color-coding. See “Setting Delta Preferences,” on page 193 
for more information.

Click Prev Diff to navigate to the previous difference.

Click Next Diff to navigate to the next difference.

Select the Hide identical properties check box to show only 
those design properties that are different. For example, in 
LotusScript code, identical subroutines in the two databases do 
not display.
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When you select Show Differences on a form, you see a preview window 
displaying the element from Database 1 in the left pane and the element from 
Database 2 in the right pane.

Showing Tabbed Tables

By default, tabbed tables within a form are hidden and display the same as they 
appear on the actual form, one on top of the other.

To view the content on each tab, select the Expand Tabbed tables check box.
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This lists each tab one below the other. You scroll down to review the content on 
each tab.

Showing Data Document Differences from the Notes Client

Delta lets you compare two data documents without leaving their database.

To compare two data documents from within their database

1. Open the database in Notes.

2. Select two documents in the same view to compare. (You cannot select documents from 
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two different views.)

3. Choose Delta of 2 Documents from the Actions menu in Notes. (This menu choice is 
unavailable until two documents are selected.)

4. The Show Differences window opens, displaying the first document in the view in the 
left pane and the second document in the view in the right pane.
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Matching Elements or Documents

When Delta compares design elements, it identifies corresponding design elements 
as those with identical names and of the same type. When Delta compares data 
documents in a view, it identifies corresponding data documents as those in the 
same position in the view.

In Delta’s main window, corresponding design elements or corresponding data 
documents display side-by-side in two panes. Design elements or documents in 
Database 1 display in the left pane and design elements or documents in Database 2 
display in the right pane.

The two panes are synchronized, so that as you scroll through design elements or 
documents in one pane, the content in the other pane scrolls with it, keeping 
corresponding items side-by-side. You click the plus/minus signs to expand/
collapse the content.

Why Use Matching?

If two elements are of the same type, but their names have changed, Delta will not 
consider them corresponding and will not automatically list them side-by-side for 
comparison. Using Delta’s Match feature, you can force the two elements to 
correspond so you can show the differences between the two.

Delta matches documents that correspond to each other in a view. If a document’s 
position in the view has changed between the two versions of the database you are 
comparing, Delta will not be able to automatically list them side-by-side for 
comparison. Similarly, two documents may be versions of each other, but if column 
sorting causes them to appear in different positions in the view, Delta will assume 
they are unrelated documents. Using Delta’s Match feature, you can force the two 
documents to correspond so you can show the differences between the two. 

The two elements or documents you match remain matched until you exit Delta or 
you match them to something else.
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To match two elements

1. Select an element title in one pane.

2. Select the element title you want to match in the other pane.

3. Right-click one of the two element titles.

4. Choose Match from the shortcut menu.
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Delta matches the two elements by redrawing the view with the elements you 
selected aligned. The matched element in the right pane will display without a 
name.

You can now compare the differences between the two elements. See “Viewing 
Differences,” on page 181, for more information.

If the two elements you have selected are too dissimilar, the Match option will be 
inactive. Instead, you can use Compare to quickly view differences between the two 
elements without matching them.

When You Can’t Match Elements or Documents

With Delta, you can compare two non-corresponding or dissimilar design elements 
to view their differences. The elements or documents could differ in many ways. 
These two elements may be of the same type but have different names, for example, 
two completely different forms. They may be of two different types, for example, a 
form and a subform. They may be hierarchically below the design element level, for 
example, two fields on a form. Or they may be CD records, the sub-elements of rich 
text fields.
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In any of these cases, you must Compare the two elements to display their 
differences. 

You may want to look at the difference between two documents but not want to 
match them. Since you can’t view Differences for non-corresponding documents, 
you will have to Compare them. 

Using Compare, you can view the differences between any two design elements or 
two documents, even though they are not similar.

To compare two unmatchable design elements

1. Select one element in each pane.

2. Right-click one of the two element titles.

3. Choose Compare from the shortcut menu.

Note When you use Compare, the two design elements or documents are 
not considered matched for reporting purposes.
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The Show Differences window opens, displaying the element from Database 1 in the 
left pane and the element from Database 2 in the right pane.

4. Double-click one of the form names at the top of the panel to show the form’s visual 
representation of forms, sub-forms, pages or navigators and compare for differences.

You use the Differences feature for items that are lined up with the like item in the 
other pane. You use the Compare feature for items that are anywhere on the lists.

Note The displayed information differs depending on the type of elements being 
compared.
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If you use Compare to show differences for a visual design element, you will first 
see the text differences in the Show Differences window. To see the visual 
differences, double-click an item within the Show Differences window.

Understanding Comparison Results

Setting Delta Preferences

You can set preferences for how the Delta Show Differences window appears. You 
can specify the fonts used in one or both panes and you can specify how white 
space is seen in Delta.

You can set font preferences as follows:

• Define the font for elements that are identical

• Define the font for elements that are different

• Define the font for elements that only exist on the left side

• Define the font for elements that only exist on the right side

• Restore defaults
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The following window shows the normal font. This window is the same for other 
font definitions.

You can define how white space appears. If one area contains spaces and the other 
contains tab characters, Delta treats this as a difference. Though this is not a 
difference that affects other functions of the code, it is still a difference.

• Click None to treat each difference in white space as a difference.

• Click Leading to ignore all white space characters at the start of a line.

• Click All to ignore white space characters throughout each line: at the beginning, 
between words and at the end. Multiple white space characters between words are 
treated as one.

Note Delta defines white space as space or tab characters only.
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Filtering Data Document Comparison Results

You use the following check boxes to filter the comparison results:

Check box Description

Select Hide Identical Objects (the default) to list only 
elements and documents that are different in the two panes. 
Clear this check box to see the complete database design—
elements and documents that are identical and elements and 
documents that are different.

Select Smart Filter to hide or filter information that is of no 
practical interest when comparing the database designs.

For example, an Agent stores information about the last time it 
was run. This is likely to be different between two different 
copies of a database, but does not really mean that there are 
differences in the design. With Smart Filter selected, Delta 
ignores that attribute.

Select Hide Unique Notes to hide notes that exist in only one 
of the databases you are comparing.
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How the Smart Filter Works

Advanced users may be interested in how Delta’s Smart Filter works and what 
Delta hides when the Smart Filter check box is selected.

Default data document fields filtered out are:

• Anything beginning with $CIAO

• $Links

• $Ref

• $Revisions

• $UpdatedBy

See “Configuring the Smart Filter,” on page 197 for information on how to 
configure the Smart Filter. 

Hiding an Item with the Smart Filter

You use Smart Filter to hide items you don’t want to see when viewing the results 
of a comparison. First, you add an item to the Smart Filter. Then you enable Smart 
Filter.

To add an item to the Smart Filter list

1. Right-click the item or CD record’s name to display the shortcut menu.

2. Choose Add to Smart Filter. 

When Smart Filter is enabled, Delta hides the item or CD record. 

You can change settings about what to hide using the Configure Smart Filter window.
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Configuring the Smart Filter

Delta filters a standard set of element items and fields when the Smart Filter check 
box is selected on Delta’s main window.

You can customize the Smart Filter to filter only what you specify. These element 
items and fields include:

• CD Records (for example, individual paragraph records or text records)

• Particular design element fields (for example, $$$FormScript_O or $$SCRIPT_O)

• Anything you have added with the Add to Smart Filter feature

To configure the Smart Filter

1. Click Preferences > Smart Filter Options.

You see the Smart Filter window. Highlighted elements are always visible.
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2. Select a type.

3. Do one of the following:

– Deselect (unhighlight) the elements you want to hide.

– Click Show All to select (highlight) all elements, so that all will appear when the 
Smart Filter is turned on.

– Click Hide All to deselect (turn off highlighting) all elements, so that none will 
appear when the Smart Filter is turned on.

– Click Default to accept Smart Filter’s defaults. This is information that is typically of 
no interest to a developer. This restores factory settings.
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Sharing Design Changes through Merging

Delta’s merge feature lets you quickly share design changes you choose between 
two databases. When you merge, you replace an object from one database with a 
copy of the object from another database. Note that merges in Delta happen in 
realtime.

Manual merging in Delta works on the object level. You can merge most objects 
from one database to another as long as the target database has the same “container” 
as the source. For example, a button in a form called Employees can be merged into 
another form called Employees in another database.

To merge elements from two databases

You can merge elements from one database to another as follows:

1. With the source and target database displayed in Delta, right-click in one database on 
the element you want to merge to the other database.

2. Select Merge to the Right or Merge to the Left from the menu that appears.

The element is merged into the other database.
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Common Uses for Manual Merging

You can use manual merging in a variety of ways:

• Moving bug fixes or changes in an older version of an application to a newer version.

• After upgrading a third party application, merging modifications you have made to a 
previous version.

• Adding action buttons to forms.
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Creating Difference Reports

You can save and print a report listing all of the design element or document 
differences in a database. If the report provides too much or not enough detail, you 
can filter the results using the Options on the General tab (See “Delta Options,” on 
page 178) on the Teamstudio Delta Reporting window, or the settings on the CD 
Filter tab (See “Filtering Low-level Information,” on page 207).

If you are printing document differences, be sure to read “Simplifying Data 
Document Reports,” on page 209.
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To create a Difference Report

To create a Difference Report, you specify the report’s description and output 
database location. Then you specify any options you want that will filter or change 
the report results.

1. To create a Difference Report, choose Report from the Delta main window. 

You see the General tab of the Teamstudio Delta Reporting window.
202 – Teamstudio User Guide



TEAMSTUDIO DELTA
In the Description box, Delta provides a default description for the report, based on the 
names of the databases being compared. This title identifies the report document in the 
output database, which is a Notes database. 

2. Optionally, replace the default description with your own description. 

3. In the Write report to section, click Select.

You see a list of databases based on the reports template.  

4. Select an existing database or specify a new database server\pathname.

By default, Delta creates a separate document for each comparison of two design 
elements or of two documents. This makes it easier for you to navigate through large 
Delta reports. 

If your database is small (or if you prefer) you can create the report as a single 
document. 

5. If you want the report as a single document, clear the Use a separate response 
document for each design element check box.

6. In the Options section, click to select the options you want that will filter the report 
items displayed, as described in the table.

7. Click OK.

Note If you plan to run a report more than once, consider providing 
a different report description, perhaps including the date and 
time, each time you generate the report.

Note The reports template name is TMSLogs and the file name is 
tmslogs.ntf.

Tip Remember that if you clear this check box, your report may be 
extremely long, because all design elements or documents 
(depending on what Delta is comparing) are contained within 
one report document.
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Report Options

The following report options are available:

Option Description

Smart Filter Select Smart Filter to hide or filter information that is of no 
practical interest when comparing the database designs.

For example, an Agent stores information about the last time it was 
run. This is likely to be different between two different copies of a 
database, but does not really mean that there are differences in the 
design. With Smart Filter selected, Delta ignores that attribute.

Hide identical objects Select the Hide identical objects check box to include in the report 
only elements or documents that are different. Clear this check box to 
include in your report the complete database design--elements and 
documents that are identical and elements and documents that are 
different.

Hide properties Select the Hide properties check box to list the name only of design 
elements or documents that are different. Details about the 
differences are not included in the report, so you cannot learn what or 
where the differences are. This option produces a significantly 
shorter report.

Hide identical properties Select the Hide identical properties check box to exclude from the 
report any identical individual properties for an object with 
differences. This means that objects with differences are included in 
the report, but within those differences any identical properties are 
excluded. This option produces a shorter document for each design 
element or document comparison.

Hide unique Notes Select the Hide unique Notes check box to exclude from the report 
any Notes that exist in only one of the databases you are comparing.
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About Difference Report Symbols

A symbol displays beside each element or document.

About Difference Report Fonts and Colors

You use options on the Appearance tab to specify how Delta indicates differences 
in the report. By default, Delta uses the Helv font as follows:

Mark Description

Blue checkmark Items are identical. Clear the Hide Identical check box to show 
identical items.

Checkmark with 
an asterisk

There are differences among child  documents. This only 
appears when comparing data.

Red X Items are different from each other.

Green left arrow Item exists in Database 1 (on the left) but not in Database 2 (on 
the right).

Blue right arrow Item exists in Database 2 (on the right) but not in Database 1 
(on the left)

Gray diamond Identifies a save conflict for two corresponding items.

Text Color Representation

Black Items in both databases are identical.

Red Items in both databases are different.

Green Items appear in Database 1 (on left) but not in Database 2 (on the right).

Blue Items appear in Database 2 (on right) but not in Database 1 (on the left).
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You can change these default typefaces and colors on the Appearance tab. 

To change any one of the font typefaces

1. From the Appearance tab of the Reporting window, click the check box at the top of 
the window.

2. Click the ellipse “…” button to the right of the appropriate font definition. 

You see the font window.
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3. Make the font changes you want.

4. Click OK to accept the changes.

Filtering Low-level Information

CD records store the rich text definitions of form and subform design layouts. They 
are complex by nature. Making even a small change in the layout of a form can 
cause significant differences at the CD record level. From the CD Filter tab, you can 
filter out low-level information that is not significant in comparing two design 
elements or two documents, for example, differences that show up as a result of a 
simple form layout change.

The CD filter gets its initial settings from the Smart Filter. You can make changes in 
the filter for a single report as follows:

To filter CD records

• To filter CD records in the report, select the Check here to select the composite 
records you want to include in the report check box.

Important Working with the CD Filter is an advanced option. Use 
the CD Filter only if you understand the internal 
structure of a design element.
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The list box on the left lists the following container types:

The list box on the right lists all the CD records for the selected container type.

• Click Show All to select every CD record for the selected container type.

• Click Hide All to clear any selections for the selected container type.

• Click Default to use Delta’s default CD record selection for all container types.

The various types of CD records are defined in the IBM Lotus Notes C API manual. 
For most users, Delta’s default settings are sufficient and you will not need to 
change them.

See “Configuring the Smart Filter,” on page 197 for information on how to use the 
CD Filter. 

Container Type Description

CD Records A container for rich text such as $BODY

Navigators A container for navigators

Actions A container for actions on forms and views

Note Keep in mind that the custom CD Filter selections you make are 
not saved. You must re-customize CD Filter the next time you 
create a report with Delta.

Caution If you are customizing the CD record selection for only one container type, 
click Default before you begin. This sets up the default selection for all 
containers types. You can then select the container you want to customize 
and proceed. If you click Default after you customize the selection for a 
container type, that container type’s selection reverts to the default.
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Simplifying Data Document Reports

Notes’ internal handling of various fields such as rich text items may make it 
difficult for you to get a simple report for documents. The following procedure can 
help.

To configure a simple data document report

1. From the Report window, click the CD Records tab.

2. Click the CD Records container type in the left list box to display all of its CD Records 
in the right list box.

3. Click Hide All to clear any selections for CD Records. Selections for other container 
types are not affected. 

4. Select the following CD records from the CD Records container:

– Text

– Field

– Keyword

– Ext Field

– Ext2 Field

Note Keep in mind that the custom CD Filter selections you make are not 
saved. You must re-customize CD Filter the next time you create a 
report with Delta.
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Viewing Reports

After you set up any options on the Teamstudio Delta Reporting window, click OK 
to generate the report. A status bar appears while the report is generated. Upon 
completion, you see a confirmation message.

Viewing Delta Reports

To view a report, open the output database where you stored the report. Then locate 
and open the report document.

The icons beside each item tell you whether items are identical or different.You can 
drill down within the view by clicking twisties. You double-click an item to see its 
report. 

At the top of the report you see the report options in effect when this report was 
generated. Within the body of the report, you see the text in the default colors or the 
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colors you selected on the Appearance tab.
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Introduction

Congratulations on your purchase of Teamstudio Design Manager!

Download the Teamstudio Installation Guide for instructions on installing and 
removing your Teamstudio tools.

Teamstudio Design Manager enables and encourages code reuse by letting you 
build and share libraries of reusable design elements. The elements are stored in 
Notes templates. Design Manager helps you to organize, search, preview and use 
these elements in a database design.

Teamstudio Design Manager
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With Design Manager you can quickly and easily create Notes databases from 
standard libraries of components.

You can use any Notes database or template as a library. Using Design Manager to 
manage these templates provides several benefits that complement linking elements 
using Notes templates:

• You can manage and control linking with Design Manager. Design Manager’s Library 
(left) and Database (right) panes show template-linked elements in bold typeface, 
making it easy to determine from which template elements are inherited.

• Design Manager includes additional features to help you with development and to 
improve consistency. For example, Scan for Dependencies finds any missing dependent 
elements. Group Objects allows you to associate a set of design elements into a single 
reference name that you can then drag and drop into target databases.

• Design Manager identifies dependencies and automatically copies them to the target 
database design if necessary.

• With Design Manager, you can track the history of elements copied from a library file 
to a database you specify.

• Design Manager lets you view all elements copied to a database and all databases that 
an element has been copied to.

• Design Manager lets you change the design refresh property on one or more databases 
at a time.
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Starting Design Manager

In Designer, open a Notes database and then click the Design Manager button on 
the toolbar.

Once Design Manager has started, you see the Design Manager main window. 
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About the Design Manager Window

The Design Manager window is divided into the following panes:

Pane Description

Left You use the Library>Open command to open any template or database in the left 
pane. The left pane is a read-only area from which you can copy elements to 
databases or templates you display in the right pane. You can refer to databases or 
templates you see in the read-only area as libraries. When you have one or more 
libraries open, the design elements in each library are listed in the left pane.

Template-linked elements appear bolded in this pane.

See “About Template Inheritance,” on page 237 for more information. 

Right You use the Database>Open command to open any template or database in the right 
pane. You can add or delete elements in the right pane. To add elements, you copy the 
elements you want from the left pane into the right pane.

Template-linked elements appear bolded in this pane. See “About Template 
Inheritance,” on page 237 for more information.

The CIAO! icon appears beside databases that are watched by CIAO!. 

Bottom The bottom pane is a multi-purpose area that, by default, displays log entries. Log 
entries give you a history of the operations that Design Manager has executed. You 
can also use this pane to preview visual design elements (forms, sub-forms, 
navigators, database icons, help/about and help/using documents). If you select an 
element in the left or right pane, you can preview it in the bottom pane.

Note You can copy text in a Log pane to the clipboard by choosing Copy from the 
Edit menu, or pressing CTRL+C on your keyboard. You can then paste that 
text to another location.
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Building a Library You Can Share

You can build a library of the elements you choose from one or more databases or 
templates. Once you build a library, you can share it with other users by placing it 
on a Domino server.

Opening a Database

With Design Manager you can open a database you want to add elements to. The 
database elements display in the right pane.

To open a database

1. Choose Open from the Database menu (or click Database > Recent Files to select 
from the last ten databases opened).

You see a list of databases and templates in your local data directory.

2. Select the database you want to open.

Note You can select a server from the Server dropdown to display a list of databases 
and templates on the server you select.

Use the Open Database toolbar button as a shortcut to the
Database > Open command.
Teamstudio User Guide – 217



BUILDING A LIBRARY YOU CAN SHARE
3. Click Open. 

You see the database elements in the right pane.

Note Use the right-click menu in the left pane to open the selected library in the right 
pane where you can change it.
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Opening a Library

A library is a Notes template or database you open in the left pane that holds 
reusable elements that you can copy to databases in the right pane. You can open 
any database or template as a library.

To open a library

1. Choose Open from the Library menu (or click Library > Recent Files to select from 
the last ten libraries opened).

You see a list of databases and templates in your local data directory.

2. Select a server to display libraries on your network, or use the Local server. 

In the Database list, you see a list of databases and templates on the selected server.

Use the Open Library toolbar button as a shortcut to the
Library > Open command.
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3. In the Database list, select the template or database you want to use as a library.

4. Click Open. 

You see the library elements in the left pane.

Once you have opened a library for the first time, you need not select the library 
from the list again. The next time you start Design Manager, it will automatically 
open the same libraries that were open previously.

Opening Used Libraries

When you open used libraries, it is easier to find the library you may need for a 
design refresh.

To open all libraries that a database design inherits from, select at least one database 
in the right pane and then choose Open Used Libraries from the Database menu. 
Design Manager then prompts you for a server to search. Design Manager displays 
a list of matching templates in the left pane.

To identify and open all the libraries used by a particular database design

1. Select at least one database in the right pane.

2. From the Database menu, choose Open Used Libraries

3. From the Server dropdown, select the server you want to search, then click OK.

Note Use the right-click menu in the Database pane to open the selected database in 
the Library pane.
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Closing Libraries
• To close one or more libraries in the left pane, select the library (click the library name 

in the left pane) and press the DELETE key.

The library is immediately removed from the pane.

• Alternatively, select the library by clicking its name in the left pane, and then choose 
Close from the Library menu.

• You can also choose Close All from the Library menu to close all open libraries.

Opening Inherited Databases

Inherited databases inherit their design from templates. If you made a change to a 
template, you may want to update all databases that inherit from that template.You 
can open inherited databases as follows:

To open inherited databases

1. Select one or more templates in the left pane.

2. From the Library menu, click Open Inherited Databases>Inherited at Database 
level or click Open Inherited Databases>Inherited at Design Element level.

You see the Open Inherited Databases window.

3. From the Server dropdown, select Local for databases that are on your PC or select a 
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server for a remote database, then click OK.

You see the inherited databases in the right pane.

Grouping Objects

Using Design Manager, you can group design elements that are frequently used 
together, making it easier to drag-and-drop a group of two or more design elements 
into a database design. For example, if there are several design notes you often use 
together to capture customer information, you can group them together to form one 
object you call Customer Data.

If the Copy History Log is active, Design Manager records information about a 
group object every time you create or edit a group object.

Creating Group Objects

To create a group object

1. Hold down the CTRL key as you click each of the elements in the right pane that you 
want to group together.

2. From the Database menu, choose Create Group Object.

3. Enter the name of the Group Object.

For example, if you chose Main Topic, Response and Response to Response to form a 
new Group Object, you may want to name that Group Object “Discussion Topic 

Note Databases to which you have insufficient access will not appear in the 
right pane.

Notes • All selected elements must reside in the same database. 

• A group object cannot be a member of another group object

• Actions cannot be members of group objects. 

• Group object members must be elements.

Use the Create Group Object toolbar button as a shortcut to the Create 
Group Object command on the Database menu.
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Forms.”

Design Manager then records in the Log pane that the Group Object has been created. If 
the Copy History feature is active, Design Manager records details of the group object 
creation and its component elements in the Copy History Log.

If there are any group objects in a database, the Group Objects category is added to the 
list of categories in the Database pane.

4. Expand the category to reveal the groups you have created.

5. To view the elements in a group, select that group. 

Its elements are listed in the preview pane. Now that the Group Object has been created, 
you can easily drag-and-drop the Group Object into your open database. Although you 
create a group object in the right pane, you can only drag and drop it from the left pane.
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Editing Group Objects

Once you create a Group Object, you can add or remove elements from the group or 
rename the Group Object. You can also identify dependencies, that is, find out 
which elements are dependent on other elements.

1. Expand Group Objects at the bottom of the Database pane to reveal groups you have 
created. 

2. Select a group name and then choose Edit Group Object from the Database menu.

You see the Edit Group Objects window that shows a checkmark beside each element 
included in the group.

3. Select additional elements to add them to the group or clear checkmarks beside selected 
elements to remove them from the group.

a. If you want to find out which elements are dependent on another element, right-
click the element and then choose Identify Dependencies from the shortcut menu.

The element you selected and its dependent elements display as blue, underlined 
typeface. Selections containing those dependent elements are expanded. This does 
not change the group. You can use this feature to help determine what to add or 
remove from the group.
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b. Choose Deselect Dependencies from the shortcut menu to clear highlighted 
dependencies.

4. When you are finished editing the Group Object, do one of the following:

– Click Cancel to exit the Edit Group Objects window without saving any changes.

– Click Revert to restore the original group definition. The Edit Group Objects 
window remains open.

– Click Save to save your changes and close the Edit Group Objects window.
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Organizing a Library

You can organize a library by comparing elements and deleting the elements you no 
longer need, adding those you want, arranging actions in the order you want, and 
adding comments to or changing properties of design elements.

Organizing Actions in a Library

As you organize a library, you can make actions shared or unshared, copy actions, 
and change the location of actions on the action bar.

Making Actions Shared or Unshared

You can make an action shared or unshared as follows:

To make an action shared or unshared

• From the right-click menu, select the Make action(s) Shared command to convert a 
regular action into a shared action. 

• This menu command is context-sensitive. If the action is already shared, select the 
Unshare Action(s) command from the right-click menu to convert the action into a 
regular action.

Action example Description

Actions appear with the action icon as children of notes.

Shared Actions appear with italicized text under the Shared Action 
note.

Broken Shared Actions are action references where the original action 
has been deleted. They appear with a strike-through and italicized text.
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Moving Actions on the Action Bar

Use the right-click menu and select Move Action Up or Move Action Down to 
change the order in which actions appear on the action bar. Use Move Action Up to 
move an action to the left on the Action Bar. Use Move Action Down to move an 
action to the right on the Action Bar.

Deleting Elements

You can delete an element in a database design from within Design Manager. Select 
the element you want to delete and press the DELETE key. Design Manager prompts 
you for confirmation before it deletes the element.

Note Shared actions cannot be moved up or down.

Note If you have the database design open in the Notes Designer client, the 
view of elements will not be automatically refreshed when you exit 
Design Manager. You can refresh a view of design elements in Notes 
Designer by pressing the function key, <F9>.
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Comparing Elements

You can use Design Manager to compare any two design elements, either in the 
same pane or in different panes. For example, if you believe that the version of an 
element in a library may be an updated version of the same element in the database, 
use Compare Elements to compare the two elements. Similarly, you can compare 
two elements with the same name in two different libraries.

To compare two design elements

• Select the two elements to be compared (use the CTRL key if they are in the same pane), 
and then choose Compare Elements from the Tools menu.

Adding Comments and Changing Properties

You can add comments to a design element. The comments display in Design 
Manager’s Comment field when you select the element. You can also change design 
element properties, for example, the Title, the Inherit from Template name or the 
flag that stops a design refresh or replace operation from changing the element’s 
code.

You can also use the Compare Elements toolbar button as a shortcut to the 
Compare Elements command on the Tools menu.
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To add a comment and change the properties of a design element

1. In the right pane, right-click the element you want to add the comment for.

You see the shortcut menu.

2. From the shortcut menu, choose Properties.

You see the Property window.

3. Enter the following:

If the database is a template, the template name will appear in the Database is a 
Template field.

4. Click Save.

Item Description

Title Element, action or database name

Inherit from Template The template from which you want this template to inherit

Prohibit design refresh 
or replace to modify

Select to ensure the design element’s code remains unchanged by any 
design or refresh operation

Comment Any text you wish to use as a comment
Teamstudio User Guide – 229



ORGANIZING A LIBRARY
Previewing Visual Elements

As you work with select elements in Design Manager, the preview pane (the bottom 
pane) shows you how certain element types will look.

To switch from the log view to the preview mode

• From the View menu, choose either Library Preview or Database Preview. 

Use the Library Preview toolbar button as a shortcut to the View > Library 
Preview command.

Use the Database Preview toolbar button as a shortcut to the View > 
Database Preview command.
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When you choose Library Preview, the Preview pane shows a preview of the 
element that you selected from the left pane. When you choose Database Preview, 
the Preview pane shows a preview of the element you have selected from the right 
pane.

To switch from the Preview mode to the Log mode

• Choose Log from the View menu to switch the Preview pane back to the Log mode. 
You will see a text log of Design Manager’s actions.

Viewing Elements

Use Expand/Collapse All on the View menu to view the sub-elements of a 
database or library.

Alternatively, select the database or library for which you want to view sub-
elements, and right-click to display the short-cut menu. Then click Expand All or 
Collapse All.

You can click the twisties at each hierarchical level; or use the following keyboard 
shortcuts to quickly expand and collapse the twisties.

Tip Click any element in either the left or right pane. This automatically switches 
the bottom pane to the appropriate view, with the selected element displayed.

Use the Log toolbar button as a shortcut to the View > Log command.

Shortcut Usage

* Expand All

+ Expand

- Collapse
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Viewing Aliases

Click the Show Alias command on the View menu to view alias names in both the 
left and right panes.

This is with Show Alias enabled.

This is with Show Alias disabled.

Selecting Child Elements

If you want to perform operations on multiple elements, you can automatically 
select the child elements of library or database elements by choosing Select 
Children from the right-click menu.
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Working with Databases and Libraries

Using Library Filters to Display Fewer Elements

Use the library filter to search, then filter the left pane. A library filter is a text-
based search that restricts the entries in the left pane to just those that match your 
search criteria.

When you specify a filter, Design Manager searches all design elements in all 
libraries for a match. Because this search includes the contents of each element, 
rather than just its name, you can include searches for field names and LotusScript 
subroutines.

To set up a filter

1. Choose Filter from the Library menu. 

You see the Filter window.

2. In the numbered fields, enter one to eight terms to search for.

– To match by any of the words you entered, click the Any option.

– To restrict search matches to only those design notes where all of the text items 
match, click the All option.
Teamstudio User Guide – 233



WORKING WITH DATABASES AND LIBRARIES
3. Further define the search by selecting the options you want from the following check 
boxes:

4. When you are satisfied with your selection criteria, click OK to begin the search.

When the search completes, the left pane shows only those design elements that match 
the criteria you defined.

To clear the filter

• To clear the filter, choose Clear Filter from the Library menu.

Saving the Database List

You can automatically save the list of databases that are open in the Database pane 
when you exit Design Manager.

• To save the list of databases, click Database > Save Db List on exit.

When you next start Design Manager, it automatically opens the list of databases 
you had open the previous time it ran.

Check Box Description

Whole words only Only matches if the words are surrounded by white space (or 
punctuation).

Case Switches case sensitivity on.

Accent Switches sensitivity on for accented characters.

Use the Filter toolbar button as a shortcut to the Library > Filter 
command.

Use the Clear Filter toolbar button as a shortcut to the
Library > Clear Filter command.
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Closing Databases

You can select one or more databases to close, or you can close all open databases 
in Design Manager.

To close one or more databases

• To close one or more databases in the right pane, select the database by clicking its 
name in the right pane. Then click Close from the Database menu. 

The database is removed from the right pane.

To close all databases

• You can also click Database > Close All to close all open databases.

Copying Design Elements Using Drag-and-Drop

You can use drag-and-drop to copy design elements, along with their dependencies, 
from an open library template or database into an open database. (See “Identifying 
Dependencies,” on page 239 for more information.)

Copying Actions

You can copy actions from the left pane to the right pane using drag and drop or by 
clicking the blue arrow buttons.

• If you drag and drop an action onto a database name, the action is copied into the 
Shared Actions note.

Design Manager creates a Shared Actions note if one does not already exist.

• If you drop an action onto a form or view, the action reference is copied into that form 
or view.

• When you copy an Action reference from a form, for example, Teamstudio Design 
Manager looks up the shared action, then creates a copy in your destination form that is 
not shared.
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To copy an element from the left pane to an open database

See “About Template Inheritance,” on page 237 before you begin copying.

• To copy an element from the left pane into the open database in the right pane, click the 
element in the left pane, and then drag it into the right pane. 

If you are using the Copy History Log feature(See “Setting the Copy History Log,” 
on page 245), each copy activity from Design Manager is recorded.

Copying Duplicate Elements

Design Manager checks the target database to determine if elements with the same 
name already exist. It compares the title and aliases, not the design. When it finds 
the same element, you see the following message:

Notes • You cannot copy from the database in the right pane to the template or 
database in the left pane.

• When using drag and drop, you can only copy into one target database.
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Then you can choose from the following options:

About Template Inheritance

By default, when you copy a design element from a Notes template in the left pane 
using drag-and-drop, Design Manager will template-link the copied element to the 
template. In other words, the resulting element is set up to inherit its design from 
the original template.

To copy without template inheritance using drag-and-drop

You can override the default behavior, copying an element to a new database from 
the template without maintaining the inheritance as follows. 
1. Choose Tools from the Design Manager menu bar. 

2. Choose Inherit Design on Copy to clear the checkmark.

3. Drag-and-drop the element.

The element is not linked to the originating template.

You can also use the following toolbar buttons to copy elements from the left pane 
to the right pane, with or without inheritance: 

Button/Check box Description

Add Add another copy of the element.

Replace Replace existing element with new element.

Skip Don’t copy the element. Move on to the next (only available when 
multiple elements are selected to copy).

Cancel Cancel the operation.

Apply to all elements Selected option (above) is applied to all duplicate elements found 
(only available when multiple elements are selected to copy).

This button copies selected design element(s) from the library pane to all 
selected databases in the database pane, maintaining template inheritance.

This button copies selected design element(s) from the library pane to all 
selected databases in the database pane, without maintaining template 
inheritance.
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Elements linked to a template display in bold typeface in both the left and right 
panes; elements not linked to a template display in a normal typeface.
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Identifying Dependencies

A dependency is an element that another element requires in order to work properly. 
For example, if you have a form that uses a subform, the subform is a dependency 
of the form. The form will not work properly without the subform. When you copy 
an element, consider whether the element has dependencies you should also copy.

If you have a library with a number of reusable elements, you can quickly create a 
customized application simply by dragging or copying standard elements from the 
left pane to the right pane.

You can see which elements are dependencies as follows:

To see which elements are dependencies

1. Select the element you want to copy.

2. From the Edit menu, choose Select Dependencies.

Elements that the element you selected is dependent on display with a checkmark.

Use the Select Dependencies toolbar button as a shortcut to the Edit > 
Select Dependencies command.
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To select references

Element references show which design elements reference the selected element(s). 
You can select references as follows:

1. Select an element you want to select references for.

2. Right-click to display the short-cut menu and choose Select Reference of Selected 
Elements(s).

All forms that reference the element you selected are now selected.

To open used libraries

You can open libraries used by a database or template as follows:

1. Select a database or template in the right pane.

2. From the Database menu, choose Open Used Libraries.

3. Select the server where the libraries are located.

You see additional libraries in the left pane.
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Unlinking Template Inheritance

You can remove all template links in one or more target databases as follows:

To unlink template inheritance for a database

1. Select at least one database.

2. From the Database menu, choose Unlink Template Inheritance > All Elements in 
Selected Database. 

3. Click Yes to confirm.

All links to templates for all selected databases are removed.
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To unlink template inheritance for selected element(s)

1. Select the items in the right pane

2. Do one of the following:

– From the Database menu, select Unlink Template Inheritance > Selected 
Element(s). 

– Right-click a selected element in the right pane, and then choose Unlink Selected 
Element(s) from the shortcut menu to unlink that element from the template it was 
associated with.

Only those items you’ve selected are unlinked from their templates. All other template 
links in the target database design remain intact.

Prohibiting / Allowing Design Refresh or Replace

You can prohibit design refresh or replace on elements in one or more databases.

To prohibit/allow design refresh or replace

1. In the right pane, select your element(s) or Database(s).

2. Click Database > Prohibit (or Allow) Design Refresh or Replace.

3. Select All Elements in Selected Database or Selected Element(s).
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If you selected one or more database, you see the following window for each database:

4. Click Yes to accept.

Scanning for Missing Dependencies

With Design Manager, you can scan to find any dependent elements that are 
missing from a database design. For example, if you copied Form A, which uses 
Subform B, from a library into a database design, but you did not also copy 
Subform B, you can scan for dependencies to detect the missing dependency.

To scan for missing dependencies, select at least one database and choose Scan 
Dependencies from the Database menu.

Design Manager scans for dependencies in all selected databases. If you select more 
than one database, Design Manager processes one database at a time and prompts 
you for any missing dependencies in each database. You must select at least one 
database.

Use the Scan Dependencies toolbar button as a shortcut to the Scan 
Dependencies command on the Database menu.
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When Design Manager has finished scanning for missing dependencies, you see the 
search results in the Log pane.

Design Manager scans the open libraries for elements matching the names of the 
missing dependencies. If Design Manager finds the matching element, it gives you 
the option to copy the missing element to the database to resolve the dependency.

Note Design Manager only scans those databases that are listed in the Library pane.
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Synchronizing

Use the Database > Synchronize Design command to copy all new or changed 
design elements from a template into a database.

If the database inherits at the database level, then when you synchronize you’ll see 
options to synchronize Database Options, ACL, and Replication Settings. The 
Synchronize Design command considers the date and copies design elements that 
are new or have changed.

This functions differently than Notes design replace/refresh, as follows:

• When synchronizing designs, matches are made based on a design note’s name and 
type. If there is more than one note with the same name and type, the UNID is checked. 
If the UNID doesn’t match, then the unmatched design note is added to the database.

• All of the database options are synchronized except those that are template-specific 
including the List as Advanced Template in ‘New Database’ window, Copy profile 
documents with design, Single copy template; unlike design/refresh where only the 
specific elements are synchronized.

Setting the Copy History Log

Each time an element is copied from a source library file (database or template) to 
one or more target databases, Design Manager records that action in the Copy 
History Log. The Copy History Log records information about group objects each 
time you create or edit a group object in the target database. The Copy History Log 
is a Notes database. 

To set the Copy History Log

1. Choose Set Copy History Log from the Tools menu.

You see the Set Design Manager Copy History window.

2. Click Select to locate an existing database, or enter a path and a new database name in 
the Path field.
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3. Click OK.

If the database does not exist, Design Manager creates it.

When Design Manager finishes setting up the Copy History Log, you see a 
confirmation in the Log pane.

Once set up to record the copy history, Design Manager creates a document in the 
copy history log database each time you paste or drag-and-drop a design element 
from a source database or template to one or more target databases. Design 
Manager records, among other data, what activity occurred and who was 
responsible for the action.

When a Group Object is copied from a source database to one or more target 
databases, only the elements within that group are copied. If you want to group 
them in the target database(s) as well, you must create the group again. The Copy 
History Log database shows the individual elements that make up the Group Object 
in both the By Source Database and the By Target Database views. If you open a 
document for an individual element, and that element was copied as part of a group, 
the Action field reads Copied as Group Object and lists the original group object 
name.

The Group Objects view in the Copy History Log database shows the history of 
group objects as they are created and edited, but not as they are copied.
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• To view copy history, open the Copy History Log from your Notes workspace.

These are the views:

View Description

By Source 
Database

Shows the copy history of objects copied from the source database. Double 
click a document for more detail.

All Targets Shows where an element has been copied.

By Target 
Database 

Shows the copy history of objects copied to the target database(s). Double 
click a document for more detail.

Group Objects Shows the history of group objects when they are created or edited. See 
“Setting the Copy History Log,” on page 245, for more information. 

Note Template-linked elements appear in the Copy History Log with a green 
checkmark. They appear bolded in the Design Manager right pane.
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Copy History Log document example

The following is an example of the Copy History Log.

In this example, the element was originally part of a group object called “discussion 
group” in the source database. Information is recorded in a Copy History Log 
document for that element.

The Copy History Log document provides the following information:

• The user action (copy) causing the history event to be recorded

• The group object name, if the element was originally part of a group object

• The design element name and type

• The UNID in both the source and target databases

• Information about the source database where the element was copied from

• Information about the target database where the element was copied to

• Who copied the element

• The date and time the element was copied
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Introduction

Congratulations on your purchase of Teamstudio Profiler!

Download the Teamstudio Installation Guide for instructions on installing and 
removing your Teamstudio tools.

Teamstudio Profiler helps identify the LotusScript performance issues of Notes 
applications.

Lots of things can impact the performance of Notes applications. One area which 
often causes performance problems is poorly written LotusScript code. This type of 
problem can be difficult to pinpoint. Troubleshooting is time-consuming and error-
prone. When you use Profiler, you remove much of the “guess-work” from 
troubleshooting.

Client and Server

Teamstudio Profiler has both a client and a server component. The client 
component lets you collect detailed timing information on applications as they run 
on your client.

The server component runs on a server to monitor agents that run on that server, for 
example, event-driven, scheduled and Web agents.

Teamstudio Profiler
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Using Teamstudio Profiler Client

To use Profiler client, you run Profiler with your application, and then you review 
the results. Some circumstances are especially appropriate times to run Profiler.

When to use Profiler

• At the end of a development cycle, as part of final QA, where the code is stable, yet 
would benefit from performance improvements

• If you have assumed responsibility for older IBM Lotus Notes or Domino applications 
that would benefit from performance improvements, as opposed to additional, costly 
hardware upgrades

• If you have been assigned to maintain older applications, with which you are unfamiliar

Running Profiler With Your Application

To run Profiler with your application, you select your target database, specify 
Profiler configuration settings, run your application, and then stop Profiler.

To start Teamstudio Profiler

1. In Designer, open the application you want to profile.

2. Click the Profiler button on the toolbar.

Note Because of the way the Notes Client performs caching, you should restart 
the Notes Client before running Profiler.

Note Profiler will not let you profile a database that has a hidden design. An 
error will appear.

Click OK to accept the error and the Teamstudio Profiler window will 
appear. The Begin button will be inactive.
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You see the Teamstudio Profiler window with the name of your database in the top 
field.

Setting Profiler options

You can set Profiler options as shown in the following table.

Option Description

Function Profiling Collect timing information on functions. If you choose this option, you 
can also choose the Entry Points option.

Line Profiling Collect timing information on lines of LotusScript. This option gives 
the most detail.

Entry Points Collect information on entry points to a function. Entry Points are 
functions like Initialize, Terminate, Click and Bind Events. This option 
gives the least detail, and can show you where to start. You can only 
select this if you have also selected the Function Profiling option.

Note Line profiling is not available for code included from .lss files.
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To begin profiling

1. From the Profiler window, click Begin to start Profiler. 

2. Open your database and use it as you normally would to trigger the code that you want 
to profile.

To view the results Profiler has collected

• When you are finished, click the Profiler icon to stop Profiler.

You see the Teamstudio Profiler results window.

Note Do not save things in Designer while Profiler is running. Unpredictable 
results will occur.
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Reviewing Profiler Results

The Total Time field reports the number of seconds that your application ran. 
Seconds are the default units of time.

• Click View > Units to change from seconds to milliseconds, or milliseconds to 
seconds.

• Click a column heading to sort by that column.

The pane at the top shows the list of functions that were running during Profiler’s 
collection interval and information about those functions.

Profiler uses the following naming convention to represent classes and methods:

<class name>::<method name>

Column Description

Fn The function name.

Calls The number of times the function was called.

Time + Children The combined time including the time the function took plus the time its 
child functions took to execute.

Time The time the function took.

% Parent The percentage of total time that the function took to run in relation to 
the calling function.

Average The average time the function took to run once.

Average + Children The average time taken by the function and its children for each call 
((time + children)/calls).

Element The name of the design element in which the code is located.

Item The name of the NoteItem in which the code is located.
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To work with Profiler results

1. In the upper pane, select a function you want to investigate further.

You see more detailed information in the lower pane, with the Children tab selected by 
default. The function selected in the Summary pane called the functions listed in the 
Children tab.

Notes • Child functions do not include LotusScript language functions such as Print 
or Message Box. They also do not include Product Classes such as 
NotesDocument or NotesDatabase.

• Time in the Detail pane is relative to the Parent function’s time.
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In the example, the FINDPERSON function called the three child functions listed:

– FINDPERSONSLOWLY1

– FINDPERSONSLOWLY2

– FINDPERSONQUICKLY

The first two child functions took most of the FINDPERSON function’s time, which 
may warrant further investigation.

2. Double-click a function on the Children tab to view information about its child 
functions.

3. Use the arrow buttons at the top of the Children tab to go between levels of child 
functions.

4. Click the Source tab to view LotusScript source.

The example shows that line number 2 took the most time.
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Using the Call Tree

You can also use the Call Tree to investigate your results. The Call Tree gives you a 
different way to look at the functions called while Profiler ran.

To use the Call Tree

1. Click View > Call Tree.

You see the Calls window.

2. Select a function and click the Show Function button to automatically highlight that 
function in the main results pane.

3. Select the Combine Children check box so that similar calls appear in the Calls 
window as a single entry.
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This feature simplifies the tree. For example, if you have a loop that calls a particular 
function hundreds of times, the call tree will only show that function once. If you 
uncheck the box, all function calls will appear in the tree even if they are duplicates.

4. When you are finished with your investigation, click Close.

Profiler will ask if you want to save the file. After you specify where to save it, it is 
saved as a Profiler snapshot (.tps file).

You can also click File > Save As to save your report.
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Using Teamstudio Profiler Server

Install the Profiler Server on your Domino server so you can monitor the 
performance activity of a scheduled or Web agent.

Profiler Server uses the following databases on your server:

Teamstudio/ProfilerConfig.nsf – Where you tell Profiler what to monitor.

Teamstudio/ProfilerLog.nsf – Where Profiler keeps its results.

Profiler Configuration Database

Before you can use Profiler on the server, you must create a Profiler Configuration 
database.

To create a Profiler configuration database

1. Install Profiler on your server.

2. From a Notes client, click File > Application > New.

You see the New Applications window.

3. From the Server dropdown in the Specify New Application section, select the server 
you just installed to.

4. In the Title box, enter the title you want.

5. In the File Name box, enter Teamstudio\ProfilerConfig.nsf.

6. From the Server dropdown in the Specify template for New Application section, 

Note Profiler is not intended to be used to monitor agents all of the time. Profiler 
creates a significant performance hit each time it is triggered by an agent. 
When not using Profiler, we recommend that you disable every agent in the 
Profiler Configuration database.
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select the server you just installed to.

7. From the template list, select Teamstudio Profiler Configuration (profile.ntf).

8. Make sure that Inherit future design changes check box is selected.

9. Click OK.

Your Profiler configuration database has been created.

To profile selected agents

1. Open the Profiler configuration database.

2. Click Create Agent Config Doc to add an agent to be profiled.
Teamstudio User Guide – 259



USING TEAMSTUDIO PROFILER SERVER
You see the Select agent to profile window.

3. Click the Browse button to select a database to monitor.

4. Click the Get Agents button to view all the agents in the database.

5. Use the dropdown to select an agent from the database.

Note You must select a database on the same server as the Profiler 
configuration database.

Note Only LotusScript agents will be listed.
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6. Click Select Agent to select an agent.

You see information about the agent you selected.

7. Click OK.

Profiler will monitor the next time the agent runs.

– The green check mark means that Profiler will collect information about the agent 
when it runs.

– The red X means that Profiler is not collecting information about the agent.
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The next time the agent runs, Profiler will collect timing information and create a 
document in the Profiler Log database on the server.

Note This configuration does not affect agents run by a user.
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8. Open a document for editing.

9. Select Yes for the Enabled option.
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The following configuration information is provided in this document:

Information Description

Enabled Select Yes or No to enable or disable Profiler from 
monitoring this agent.

Agent The name of the agent.

Run Count Specify how many times Profiler should collect information 
on an agent.

Profiled Runs The number of times the agent has been run since this was set 
or reset.

Options Specify an option, as selected on the Profiler window:

• Function Entry Points - collect information on function 
entry points

• Functions and Lines - collect information on functions 
and lines of LotusScript

• Functions - collect information on functions

User Profiler will only run when the agent is triggered by a 
particular user.

Agent Signer The ID file used to sign agents. This is only required when 
run on an R5 server.

Agent Signer Password The password for the attached ID.

Note: This field is not encrypted and is stored as plain text.

Note Agent Signer and Agent Signer Password in the above table have some 
restrictions.

When running on a Notes Release 6 server, these fields can be ignored. 
Profiler server runs using the Server ID. On Release 6, code signed by 
the server ID is allowed to run unrestricted. Signing with a special ID is 
unnecessary.

On Release 5, however, the server is not granted these rights by default. 
After Profiler modifies and resigns code, the server may not be able to 
execute it. To avoid this problem, use one of the following options:

• Add the server name to the Run unrestricted LotusScript agents field on 
the server configuration document.

• Add the signer ID to the agent configuration document.
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Profiler Log Database

To view Profiler log information

1. Open the Profiler log database.

The red icon in the Time column indicates that Profiler encountered an error that 
prevented it from running on the selected code.
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2. Open a document to view more details.

3. Click the View Results button at the top of the form.

This launches Profiler to view the attached results.

You can also save the attachment to your hard drive, launch Profiler from your Notes 
client and click File > Open to open the file.

Note Profiler Client must be installed.
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Troubleshooting

The following tips may help prevent or resolve issues you could encounter when 
running Profiler:

• Because of the way the Notes client performs caching, you should restart the Notes 
client before running Profiler.

• Line profiling is not available for code included from .lss files.

• Make sure the code you want to profile has not yet been loaded when you start Profiler. 
For example, if you want to profile the LotusScript code for a button, make sure that the 
form that the button is on is not open. Otherwise, Profiler will not recognize that the 
code is running.
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Introduction

Congratulations on your purchase of Teamstudio Undo!

Download the Teamstudio Installation Guide for instructions on installing and 
removing your Teamstudio tools.

Teamstudio Undo keeps track of changes to a database so you can roll back the 
individual design elements of either templates or databases.

If the target database is already under CIAO! control, you can use Undo between 
check-ins.

You can use Undo to retrace your steps to the previous save if you are not satisfied 
with the changes you have made.

Teamstudio Undo
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About the Undo Log Database(s)

Undo saves the history of your elements in the Undo log database, undolog.nsf, 
which is located in the Teamstudio directory.

Configuring Undo to Track Changes to Your 
Databases

To configure tracking of all NTF files

Undo automatically keeps track of changes for all NTF files you work with, 
whether on your local computer, or on a server, so you don’t have to configure that. 
If you are wondering if Undo knows about your NTF file - no worries - it does!

If you prefer, you can manually configure Undo to keep track of changes to NSF 
files, or to keep track of changes within the files or folders you choose.
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To configure tracking of all NSF files or only selected databases or folders

1. In a text editor, open the Teamstudio.ini file, which is located in the data directory.

2. In the [Undo] section, change the line that says “IncludeFiles=*.ntf” as follows:

To track the following Change “IncludeFiles” line as follows

All NSF files only IncludeFiles=*.nsf

All NTF and all NSF files IncludeFiles=*.ntf,*.nsf

Just a few databases you want, 
for example, mytest1.ntf and 
mytest2.ntf

IncludeFiles=mytest1.ntf,mytest2.ntf

One directory only, for 
example, the mail folder

IncludeFiles=mail/*

Note Teamstudio recommends you only modify the IncludeFiles line if you 
have a very good reason. By leaving the default, you don’t have to try to 
remember to add a new database or update the line again for a database 
whose name has changed.
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Using Undo

Using Undo you can view Design Element changes and you can choose which 
changes to undo.

Viewing Design Element Changes

To view design element changes

1. From Designer, click the Undo button on the toolbar to open the Undo window.

2. Select the version of the design element you want to view changes for.

3. Click the Delta button to view the difference between the element in the undo buffer 

Note Undo does not keep track of changes to documents.

Note If you select a database icon from the Notes workspace and then click 
Undo, you’ll be prompted to browse to the database file. You can avoid 
having to browse to the database file by first opening the file in Designer 
and then clicking Undo from the toolbar.
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and its current version.

4. Click Close to return to the Undo client.

See “Using Delta,” on page 171 for more information on using Delta.

Undoing a Change

To rollback database design element changes

1. From Designer, click the Undo button on the toolbar.

You see the Teamstudio Undo window with the following element change 
information:

The design element type, the element name, the changes in the order they were made, 

Note You can also use Delta to compare two undo buffer design element 
versions. To compare two undo buffer design element versions:

1. Select one version.

2. Press and hold the CTRL button.

3. Select the second version (the two elements must be of the same type).

4. Click the Delta button.

Note If you select a database icon from the Notes workspace and then click 
Undo, you’ll be prompted to browse to the database file. You can avoid 
having to browse to the database file by first opening the file in Designer 
and then clicking Undo from the toolbar.
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the date and time of the changes and the signature before the changes were made.

2. Select version of the design element you want to roll back to.

3. Click Rollback to selected.

The copy of the design element captured at that time will replace the design element in 
the database.
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Introduction

Congratulations on your purchase of Teamstudio Validator!

Download the Teamstudio Installation Guide for instructions on installing and 
removing your Teamstudio tools.

Teamstudio Validator lets you report on areas within your database documents that 
no longer function correctly. Use this tool during the upgrades of an existing 
application where design changes have occurred and you want to determine where 
existing documents in the database no longer work as expected.

Validator reports on static links that no longer function by checking the target of 
both Notes document links and standard URL links. Validator reports on fields that 
no longer exist on the form/subform design, but still exist on documents.

Validator also checks keyword fields to ensure that values stored in the document 
still agree with values in the field design. Validator reports on orphaned documents. 

Validator lets you create detailed reports including:

• Errors

• Error descriptions

• Document links to the actual document

Teamstudio Validator
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Working with Validator

Starting Validator
• From Designer, click the Validator button on the toolbar.

You see the Validator window with the name of the database you selected in the 
Current Db box.
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Running Validator

To run Validator, you first set options and parameters and then you specify the 
output database’s server name and path.

To run Validator

1. Set the following Validator options:

2. You can set Validator to report on design elements or documents or both. If you set 
Validator to report on documents, you must specify By Formula or By View.

– If you specify By Formula, @ALL appears as the default. You can enter a valid 
selection formula for your search.

– If you specify By View, available views appear in the dropdown list, allowing you to 
select one of the views in the source database.

Options Description

Report All Links This will generate report documents for all doclinks, good or 
bad. Selecting this option disables the No Warnings and the 
Don’t Check URLs options.

No Warnings Validator will not report errors that are classified as warnings; 
for example, hotspots with no link specified.

Don’t Check URLS Validator will not check URLs. Do not try to check URLs if you 
are not connected to the internet.

No External Links If you select this option, Validator will report as an error any 
link that doesn’t point to the current database.

Assume Replicas are local If you select this option, Validator will not look at replica 
databases on external servers.

Don’t check fields Validator does not check for field errors.

Don’t check keyword fields Validator ignores keyword fields.

Ignore empty fields Validator ignores empty fields (fields on documents with no 
data).

Don’t check Conflicts Validator does not check conflicts.
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3. Enter the server name and path of the Reports database (Output).

4. Click Run to create the Reports database.

Validator will create the Reports database and automatically open it.

Notes • Pressing CTRL-BREAK while Validator is running will cause 
Validator to halt in place and open the report database.

• When the output database does not exist, you see the Create New 
Log Database window where you can enter the new 
Database Title.

Note All reports for Teamstudio products can use the same Teamstudio report 
database which is TMSlogs.ntf
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Understanding Validator Report Views

The report database provides the following views:
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By Created

The By Created view lists all errors found by the order created.

By Document

The By Document view lists all errors found by order of ascending note (element) 
ID.

By Error

The By Error view lists all errors found by error type.

Validator provides the following sub-views:

• Computed for Display (CFD) Fields on Doc (by Document or Field)

• Fields Missing on Design (by Document or Field)

• Orphan Agent Data

• Parent document not found

• Rep/Save Conflicts

• Wrong Field Type 
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Viewing an Error

To view a Validator error, select a report document.

 The Validator report shows the following:

• The options you have selected

• Database information

• Information about the error

• Information about where the error was found

Use this information to correct your database design.
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Common Information

The following information is common to all Validator reports.

Field Description

Time Run The time Validator generated the report.

Options The options you set when you ran the report (for example, include valid 
links in report and ignore empty fields).

Title The name of the database you searched.

Server The server location of the database you searched.

Database The database against which the report was run.

NoteID The failing element ID.

UNID The 16-byte value that is assigned to a note when the note is first 
created. This value uniquely identifies a note.

Note The name of the element.

Doclink A doclink to the failing document.

Test Name The type of test run. This is internally defined, consequently you cannot 
customize it. 

Result The result of the test (for example, Database was not found).

Error # The error number (for example, 259). This is internally defined, 
consequently you cannot customize it. 

Message Information about the potential causes of the error.
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Understanding Common Error Types

When reviewing your reports, it helps to understand the most common error types.

The most common error types are:

• Could Not Validate Document with Form

• Database was not Found

• Document/Note was not Found

• Fields Inconsistency

• Keyword Field Contains Incorrect Values

• Missing Dependency

• Orphaned Agent Data Notes

• Save / Replication Conflicts

• URL is Invalid

Some report document types (for example, orphaned agent data notes) provide 
buttons that correct problems within the database being validated. You must have 
the proper access rights to this database in order to use these buttons. If you don’t 
have the proper access rights, an error appears.

Notes Validator reports on many other types of errors, as provided by Notes.
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Could Not Validate Document with Form

This test attempts to calculate the default value formula and the input translation/
validation formula against values stored in the document. The following is an 
example:
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In addition to the information common to all reports, the Could Not Validate 
Document With Form report shows the following:

Database was not Found

The database specified in the document link wasn’t found. This means that the 
replica ID is no longer valid or the server that the database resides on is unavailable. 

Reported errors can include the following:

• File does not exist

• File not found or not a Notes database

• You are not authorized to perform that operation

Field Description

Field Field where the formula was found.

Phase This entry can have the following values:

• Load - Default value: An error occurred while checking the field’s 
default value

• Save - Input Translation: An error occurred in the field’s input 
translation formula

• Data Conversion: An error occurred when trying to convert the 
data in the document to the type of the field (for example, text to 
number) 

Formula The failing formula.

Notes Error The resulting Notes error, if available.
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The following is an example:
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In addition to the information common to all reports, the Database was Not Found 
report (unique for DocLink Reports) shows the following:

Field Description

Field The field on the document where the link was found.

Type The type of link (for example, DocLink or URL).

Format How the link was stored (for example, standard, computed or special).

Element Name Name of the element linked to by Named Element Link (only for the 
Type: Named Element).

NoteLink Type Type of NoteLink (For example, Named Element, DocLink).

DBID Database RepID.

View View UNID.

Note Note UNID.

Nearby Text Text near the error, provided as a hint.

Note A document link is composed of three parts: DBID, View and Note. Each must 
be valid for Notes to locate a doclink in the database.
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Document/Note was not Found

This error means that the element could not be found. There was an error with the 
Document ID that Validator used to try to open the document.

Reported errors can include the following:

• Bad named element reference (Type: Name)

• Entry not found in index

The following is an example:
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In addition to the information common to all reports, the Document/Note Was Not 
Found report shows the following:

Field Description

Field The field on the document where the link was found.

Type The type of link (for example, DocLink or URL).

Format How the link was stored (for example, standard, computed or special).

NoteLink Type Type of NoteLink (For example, Named Element, DocLink or Anchor 
Link).

DBID Database RepID.

View View UNID.

Note Note UNID.

Nearby Text Text near the error, provided as a hint.
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Fields Inconsistency

Fields stored on the document did not line up with fields on the design. Some 
potential causes for this include fields not needed that are deleted from the design 
leaving fields on the design that may not be used again and are just taking up space. 
Or the type of the field may have changed, for example, a text field that is now a 
number field. 

The following is an example:
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In addition to the information common to all reports, the Fields Inconsistency 
report shows the following:

Field Description

Design Name The name of the form that was used with this document.

Missing on design Lists the fields that are in the documents but missing in the design, 
along with the field size of the documents in parentheses [field-
name(size)].

Missing on doc Lists the fields that are in the design but not the documents.

Has different type States differences between the field type in the design and the field type 
in the document.

Computed for Display 
(CFD) fields stored on 
document

This shows the number of CFD fields that Validator found stored on the 
document, along with the field size in parentheses [field-name(size)].
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Keyword Field Contains Incorrect Values

Values that are currently stored in this keyword field do not agree with the values 
that would be presented to the user. One reason for this is a design change that 
caused keyword values to change. The following is an example:
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In addition to the information common to all reports, the Keyword Field Contains 
Incorrect Values report shows the following:

Field Description

Design Name The name of the form that Validator used with this document.

Field Name The name of the failing field.

Unknown Value List of values that were found in the field but were not valid choices 
according to the design.

Allowed Value List of values that the user can choose from.
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Missing Dependency

While trying to collect field information from the design of a document’s form, a 
dependent subform or shared field could not be located. The following is an 
example:

This report provides only the common information described earlier.

Orphaned Agent Data Notes

This test scans a database to identify agent data notes that are no longer being 
referenced by an agent. Agent data notes are design elements created and used by 
agents when they run. Over time, some databases accumulate hundreds of these 
elements, increasing the size of the database. Since most orphaned agent data notes 
are no longer attached to an agent, they will never be deleted. There is no easy way 
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to remove them since they do not show up in Designer.

The following is an example of a Validator report showing orphaned agents.

This report provides only the common information described earlier.
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To remove orphaned agent data notes in a report

• Click the Remove Agent Data button at the top of the window to remove the orphaned 
agent data notes referenced in this report.

To remove all orphaned agent data notes

1. Go to the view called Orphan Agent Data Notes. 

2. Click the Remove Agent Data button at the top of the window to remove all the 
orphaned agent data notes.

Save / Replication Conflicts

This test finds save/replication conflicts including the following:

• Conflicts created when a document or a design element is changed simultaneously in a 
database by multiple users.

• Conflicts created when a document or design element is changed in different replicas 
between replication sessions. 

• Conflicts created when one copy of a document is saved as the main document and the 
other copies are saved as response documents. The response documents are marked as 
Replication or save conflicts. If you edit and resave the conflict document, it becomes a 
main document and is no longer considered in conflict, however, you typically should 
merge these documents with the main copy.
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TEAMSTUDIO VALIDATOR
The following is an example of a Validator report showing a save/replication 
conflict.
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WORKING WITH VALIDATOR
In addition to the information common to all reports, the 
Save/Replication Conflicts report shows the following:

URL is Invalid

This error means that there was an error validating a URL that Validator 
encountered. Check the URL manually.

Reported errors can include the following:

• Not found

• The operation is timed out

• The server name or address could not be resolved

Field Description

Conflict note:

Last Modified The date the note in conflict was last modified.

Last Updated By The last user to update this note.

Main note:

UNID The 16-byte value that is assigned to a note when the note is first 
created. This value uniquely identifies a note.

Last Modified The date the main note was last modified.

Last Updated By The last user to update this note.

Note Validator will wait twenty seconds for a server to respond to an HTTP request. 
You can customize this value by adding the following to the Validator section in 
teamstudio.ini:

LINKURLTimeOut = TIME IN MILISECONDS
298 – Teamstudio User Guide



TEAMSTUDIO VALIDATOR
The following is an example of a URL is Invalid error report:

In addition to the information common to all reports, the URL is Invalid report 
shows the following:

Field Description

Field Field the URL was found in.

Type Type of link, in this case URL.

Format How the URL is stored, in this case in a formula.

URL The failing URL.

Nearby Text Text near the failing doclink, provided as a hint.
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CONTACTING TEAMSTUDIO
Contacting Teamstudio

If you have a question, don’t hesitate to ask. Contact Teamstudio technical support.

All Teamstudio products include unlimited technical support for the life of the then-current 
Maintenance Agreement. To receive support, please have your product serial number ready.

  

North and Latin America

800-632-9787 or 978-232-0145

Europe, Middle East and Africa

+44 (0) 1480 424600

Asia Pacific

+81 (0) 3-6230-0825

 

North and Latin America, Europe, Middle East and Africa

techsupport@teamstudio.com

 Contacting Teamstudio

By Phone

By Email
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Asia Pacific

techsupport@teamstudio.com

Before you call
• Double check the relevant sections in this manual and try to answer the question or 

solve the problem.

• Ensure that you have your product serial number available: we can’t provide technical 
support without it.

• Ensure that you are sitting at your PC with the software available when you make the 
call.

• Try to define the problem or the steps to re-create it before you call.

Maintenance Upgrades

Major Product upgrades are free of charge if you have a valid Maintenance 
Agreement. For more information on purchasing a Maintenance Agreement, please 
call Teamstudio.

Feedback

We are always eager to hear your comments and suggestions on our products. 
Please direct all feedback via e-mail to techsupport@teamstudio.com.
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